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Introduction
Note: GIS 360 runs on Windows Mobile 6.1 & 6.5, Windows CE, Windows XP, Vista, 7 and Windows 8. The 
functionalities are identical for all systems. Most screenshots in the present user manual are based on Win-
dows Mobile 6.5, as this is currently the most widespread system in use for GIS360.

GIS360 is designed as a Geographical Information System recording and logging facility. Lists of attributes 
can be specified by the user to describe the information being stored. These attributes can then be used 
to collect data at positions that the user wants. The information can then be attached to areas, points and 
linear objects in a geographical area. These areas are described on a back drop of either satellite imagery 
or maps from 14 different map servers. Attributes and geometries may be saved and used in other situa-
tions like rendering them onto Google Earth ™ for examplee.  Attributes may be edited and GNSS used to 
accurately place the geometric elements onto the map. 

This system is made for Mobile PC and Tablet PC although there is no problem using this system on a Desk-
top PC either. All the examples shown in this brief guide are for the Mobile PC environment. GIS360 has a 
list of equipment which we have been able to test this system with.  Whilst every care has been taken to 
conform to conventions, there is a variability in the features and performance of many mobile devices so 
we can not guarantee that our software will work on every product.

GNSS enable button

GNSS accept button

Edit menu

Zoom slider control

Method menu/ Graphic 
menu

Tools menu

File menu

Lattitude, longitude, altitude

Zoom window
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Option 1: Download from Carlson website

GIS360 Installation

Go to http://www.carlsonsw.com and choose to download the GIS360 version.

Once at Carlson website 
choose GIS

Choose “Free Trial”

Choose “Download a Free 
Trial”
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Choose  first GIS and then 
“Carlson GIS360”

Please type in you correct contact details 
including a valid email address, and press 
“Next” and soon after you will receive an 
email from us with download links for 
three different versions of GIS360

As soon as you click on 
one of the above links 
you will be directed to 
the download site and 
for Windows Mobile 
please download both 
files.
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Option 2: Download from GIS360 website

Go to http://www.carlson-gis360.com and choose to download the GIS360 version. 

Only the download from www.carlson-gis360.com will be shown here for simplicity.

Fill in the form and you will be sent the link 
in a separate email, to allow you to down-
load the GIS360 software.
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GIS360 first time installation

After you have downloaded the GIS360 software on your computer you have two options to install:

A) Installation on Windows Mobile 6.5 unit using Windows Mobile Device Center to copy the instal-
lation files across to the WM Device.

Important note: The installation procedure in this manual describes the installation of GIS360 on a Win-
dows Mobile 6.5 device, but for those of you who will also use the PC version of GIS360 in the following 
few pages we will show you “the difference” in the installation . Basically there is no difference, you install 
both versions directly to the appropriate device and you must NOT USE active sync or a similar program.

Please connect your WM device over USB cable to your PC. If every-
thing is OK you will soon see that you are successfully connected

Depending on the model of your unit you may have either 
only internal memory, or possibly internal memory and a
storage card. You can then decide where to install GIS360.

Copy both marked files re-
quired across from the PC to 
your WM device.
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B) Installation on a Windows Mobile 6.5 unit using a Micro SD Card to copy installation files across 
to your WM Device

Please find where the install file is located 
on your PC now 

Copy it and then...

...paste it into your Micro SD Card

you only need to
take your MicroSD Card 
from your PC and trans-
fer it to your WM device 
and start EXE file and the 
installation will start

Set the appropriate location for 
the install files and drop them 
there

A window with a question will appear on your PC, 
please answer ‘Yes’ and your install files will be cop-
ied across to your WM Device

soon after your install files will be on your WM device, ready to perform the
install procedure. This is described on the next page!
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GIS360 installation (First or second time)

After the successful transfer of 
install files to your WM device, you 
can look at your WM device screen 
and press the Windows Start but-
ton

Find the File Explorer 
and click once

Choose the location of your install 
files, device or storage card (if avail-
able), then click once on the direc-
tory under which you saved them.

You need to accept our 
License Agreement

In case GIS360 is already installed 
on your device, you must first 
remove it before installing a new 
version.

Choose the location, device or stor-
age card (if available), then click 
once on “Install_WM_GIS360.exe”

After removal you can choose a place where you wish to install GIS360. 
This normally depends on the memory size of your unit.
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GIS360 First time launch

Click once on the GIS360 
icon to start

You will now be guided through the steps that will enable you to configure GIS360 according to your 
requirements.

The installation is in progress and will take up to few minutes, depending on the processor speed and 
free memory on your particular device. As soon as the installation process is completed your unit will be 
rebooted, and you will see the following screens

Click here to enter the program Choose your country from the 
list
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Special note: Whilst every effort has been made to keep up to date with the most recent version of the 
software, some changes inevitably will be made before the manual changes. Please keep up to date by 
downloading the most recent manual from our site or from GIS360 FTP server.

Choose an appropriate 
schema. More details about 
schemas later

And now you are almost 
ready to use GIS360, maybe 
for the first time.

This is the final screen after the GIS360 
launch, with your desired settings and 
maps. Now we will set up the parameters 
to allow GIS360 to work with your GNSS 
receiver. To do so, enter the Tools menu

Basics GIS360 is an intuitive Software with an easy to use main menu screen. Here are the main 
functionalities. The menus will be explained in detail in the following pages.

Pen down and drag to pan the 
map on the screen

Increase the zoom by one 
level by tapping here

Drag the slider to increase or 
decrease the zoom level

Tap a marked position to 
move to the desired zoom 
level

Decrease the zoom by one 
level by tapping here

Grid lines may be turned on/
off using the configuration 
dialog on the Tools menu Maps MenuTools MenuGPSFile Menu Edit Menu

Collect menu

Tap here to be able to drawn 
the zoom window on the 
map
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It is essential to first enter your software key, in order to enable all GIS360 functionalities.

In the Tools menu, go to the “Key” tab. 
Click “Enter Key”

Press the Serial Number button in the 
highlighted green field first.

Now please enter the required and 
purchased Serial Number

In the “About” tab you can see that 
you are now using a full license.

GIS360 - Enter Software key
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After the purchase of a GIS360 license please go 
to www.survce.com and click on the registration 
page. A new window will open: please fill in all 
the information required.

Now you will be also requested to enter the Hardware ID 1 and 2 and your Registration 
Code. Entering those three numbers from your field unit is the requirement for getting the 
Change key, which you need to enter in your field unit to activate your license key.
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After entering the three numbers required, a new window will appear on your PC and you will see all 
of your data, plus the desired Change key. If you are using active sync and myMobiler please copy and 
paste the change key into your field unit. Now is registration process finished and you can start to use 
GIS360.

After successful registration you will also receive an 
email recording your change key.

The first evidence that your registra-
tion was successful is the fact that 
from now on all available GPS driv-
ers are listed and not only the first 15 
entries. To be able to check this please 
go to Tools/Devices/GPS. If the regis-
tration was not successful for whatever 
reason you will only see a few NEMA 
drivers listed.
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GIS360 First time launch - GPS/GNSS Settings - 
Communication ports
We can distinguish between GNSS settings with DGPS or RTK units or simple NEMA settings with low 
cost GPS recievers or PDA’s with build in GPS reciever. Please find first NEMA settings instructions:

To start NEMA settings please 
press the Tools icon the the 
main screen. 

First let us put our HOME symbol on 
the map. Please press on the main 
screen Tools icon and then HOME 

New windows will appear and 
please press now Set Home icon

Now you will be asked to click on 
new home position simply press-
ing with the pan on the Map.

Then  please press Devices icon. Then press GPS  icon.

Alternative way to press GPS 
icon and then again GPS icon In the list of NEMA devices we 

have preset of few tested devices. 

If you device is not preset 
please choose Cartogoo 
driver, Model NEMA. Port and 
Baud rate is different from 
unit to unit.
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GIS360 First time launch - GPS/GNSS RTK Setting-Communication ports

Port and Baud rate for your 
deive you can find in the user 
manual of the device

If your device has external an-
tenna connector and you wish 
to use it you need to check it 

Final proof that your settings were 
correct is the cursor on the map and 
number of satellites and singal Qual.

To start NEMA settings please press 
the Tools icon the the main screen. 

First let us put our HOME symbol on 
the map. Please press on the main 
screen Tools icon and then HOME 

New windows will appear and 
please press now Set Home icon

Now you will be asked to click on 
new home position simply press-
ing with the pan on the Map.

Then  please press Devices icon. Then press GPS  icon.
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GIS360 First time launch - GPS/GNSS RTK Setting-Communication ports

Alternative way to press GPS
 icon and then again GPS icon 

The list contains all supported 
RTK devices, if your device is 
not on the list please contact..... 
dealer/ Carlson

When you choice is done press green 
check icon

Now you will be ask to confirm 
your choice with Green check 

Now you will be ask to choose either Bluetooth or Serial connection. 
Please set Bluetooth and press search button. GIS360 will look for 
your unit now .

When the search is finished you will see all found devices. Please 
choose your unit and press OK.
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After few seconds GIS360 will either find your unit or maybe not. 
If not please check again communication paramters.

If initial communication was 
successfull GIS360 will con-
tinue “reading” informations 
from your GPS device.

Dependend on the type and brand 
of the device you will see  maybe 
different window, but basically 
sense is the same.

In this window you will get 
predefine choice of settings 
and if needed please set ap-
propriate to your need.

When done just press Green 
check

If all OK just press Green 
check

And you will see that com-
munication with your unit 
was successful.
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FEW REMARKS: StarFire™ is a Wide Area Differential GPS System
Originally, a set of regional wide area DGPS networks providing high accuracy service over independent 
continental areas Known as WCT (Wide Area Correction Transform)
Coverage for USA, Australia, Western Europe, Central & South Americas
Over time, it transitioned to a robust, unified global network
Uniform, 5 centimeter, real time service for most of the globe
Based on technology known as RTG (Real Time GIPSY) 
Developed by the Jet Propulsion Laboratory (JPL) for the National Aeronautics and Space Administration 
(NASA)
Does not have the restrictions of a classic DGPS
Distance from a base station is not a consideration
The corrections are based on data from all reference sites in the network, not just on one site
Throughput and range of the communications link are not problems
Corrections are delivered via satellite using global beams with very broad coverage

When done just press Green 
check

Easy way to see if you have your RTK or DGPS correction  is  to count 
signal strenght bars. 2 stands for DGPS, 3 for Float and 4 to RTK FIX. In 
those two screens you see only 2 bars, while making this user manual 
we used also unit with Star Fire capability.

If you wish “more” then Star-
Fire, please press this icon.

In this window you will be 
asked to set up RTK settings 
based on your own prefer-
ence and your unit capability.
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This two windows we saw on one of pre-
vious pages. And here is just as a remind-
er that you can set your elevation mask 
and if you wish to use Glonass, etc.

Please choose if you are using UHF 
Radio, or Internal or external GPRS 
modem.

In our case our GPS/GNSS unit didn’t had internal GPRS modem, 
we we decided to use GPRS Modem build in our PDA

Your profile will be saved. 
Now press please this icon

Please choose RTK output 
port

If you are using NTRIP please under Network 
select NTRIP, followed by pressing on this icon
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In this window you setup the 
NTRIP or VRS network you 
use, this is done once and 
the settings saved.

Enter the Name of VRS Net-
work (can be any name).

New entered name of your 
network will be now dis-
played und Name

Now please enter all other 
relevant informations, like IP, 
portusername and password.

And press Green check GIS360 will attempt connec-
tion the VRS server now.

Dependent on your Field unit 
you will see how are you con-
nected to the internet.

If some problem with the con-
nection to the VRS server you 
may get one or other message.

If your connection is OK you 
will be notify that Monut 
point are loaded.
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This section is to configure 
the internal GPRS in the de-
vice GIS360 is installed on

Please in the proposed list 
choose Internal GSM and 
press then this icon

If your GSM provider can be 
found in the pull-down list of 
APN Providers please select it.

If not you can enter your provider settings manually. Just leave 
it at “User” and enter APN Server, Username and Password and 
then press OK.
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Now in this window you 
need to setup, only first time 
your access to NTRIP or VRS 
Network. Press on Add now

Enter the Name of VRS Net-
work (can be any name).

New entered name of your 
network will be now dis-
played und Name

Now please enter all other 
relevant informations, like IP, 
portusername and password.

And press Green check GIS360 will attempt connec-
tion the VRS server now.

Dependent on quality of GPRS modem in  
your GPS and provider signal strenght you will 
see signal strenght in %.

If your connection is OK you 
will be notify that Mount 
points are loaded.
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Dependent on quality of GPRS modem in  
your GPS and provider signal strenght you will 
see signal strenght in %.

Press now Green check Please choose now appropri-
ate Mount point

You are almost there. 
Press Green Check

Unit is now connection 
to your VRS provider 
server.

And after few seconds you 
should see IP, port and 
Mount points details.
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Signal quality will be dis-
played as well, in our case 
44%.

Map window will automatically 
come and last thing you need to 
press is the small Satellite symbol.

GPS cursor will appear on the 
screen and quality of GPS signal 
will be displayed in the bottom 
right corner of the screen.

Usually only few seconds after 
main map window appeared you 
should see your full RTK signal 
strenght with 4 bars

To be able to see you actual accu-
racy please press somewhere on 
the coordinate bar and this win-
dow will appear. In our case 1 cm

And after some 5 to 10 
seconds you will also see sky 
view and signal strength and 
noise ratio.
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Load Maps
With internet connection

With an internet connection, WIFI or GPRS, GIS360 will load automatically the maps you 
have chosen. You only have to set the right parameters

For configuration, go to Tools/Map:

GIS360 allows you to have always 3 maps at hand, 
two layers with maps of your choice and also an 
empty map layer. You can switch between the 
maps by clicking on the “Maps” symbol.
The two maps layers offer many possibilities which 
you can define yourself.
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Load maps
Without internet connection
If you need to go on the field where you have no internet connection, you will want to 
prepare your maps in the office prior going to the field.

Make sure you are connected with the net and have set the right parameters (see page 
before)

Reduce the zoom level in order 
to see the part of the map that 
is required.
With the pen, click on the 
GPS signal in order to have it 
switched off. Once switched 
off it will appear as in the next 
image with a red bar.

Move the map with the pen until 
you obtain the required view.

Important: You can load two 
different maps with GIS360. 
You need to save two maps, for 
instance “Maysville” for Google 
Maps and “Maysville_satellite” 
for Google Satellite.

Click on “Home” in the tools menu. you can choose 

You will be presented again with the same map view as you had 
before. Now click on the exact position that you want to set as 
your home position.
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Load maps

You can now see your new 
home position

Now you can save maps around 
your home position in order to be 
able to work in areas without inter-
net connection.

Save local area map:  Click 
this button to save the tiles 
into a file for use in wireless 
blocked areas.  The area frag-
ment stored is a square of 
this edge length in metres. 

Choose the size of the 
background map

The Tiles are being saved so you can use these as maps in area with no 
internet access.

Choose the name of the back-
ground map before saving
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Load maps

Your map is loaded with the 
home position in the center.

And if you zoom out you 
should see that only limited 
map area is loaded, based 
more or less your desired 
map size, in our case 2000 
meters.

By pressing onto Maps icon you will now see your second map 
cache, in our case Bing Satellite map, once zoomed out and second 
time zoomed in.

Since these maps have a 
definite area, moving the 
map around with the pen 
will show you the actual 
map size on the screen.

The tiles are always saved into 
“My Documents”, which is also 
where you shall put any tiles 
you intend to use.
You can now use these tiles or 
choose to use them later
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Tools menu
Home Marker

Home Marker:  The house symbol de-
picts the base position of the survey. 
When you start up or select New Survey 
it draws the map cantered around this 
point. This is the default position of an 
earlier session. 
This marker can be moved. To do so, go to 
“Tools Menu”. 

Click on “Home Position”

Now you see the new posi-
tion of the Home Marker

If you have lost yourself on 
the map, there’s an easy way 
to find back to your home 
position, just go under Tools 
/Home and click on 

You have now three options, Go 
Home, Set Home or Close If your choice was  Set Home 

this window will come for 2 
seconds, asking you to tap the 
screen at the position of the 
new home position. 

Now you see the new posi-
tion of the Home Marker
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Tools menu
Home Marker on the PC
This feature on the PC is bit different  from 
WM version.  On the PC version you have also 
an option to enter exact address for your fu-
ture home position. This  is easier and faster 
then zooming and panning

Under Tools/Home  you will get 
following choice.  Please click on 
Address

Independently from the fact that your map  is  maybe load-
ed with a wrong city , but as soon as you enter the exact 
or rough address  and you press then to this icon            you 
can then to close this window press 

All that you need to do need to do is 
maybe to zoom it to a proper zoom level 
and you can start your job.

And your home position will be 
placed there and the map will be now 
cantered around new home position.
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File menu

New survey: Start afresh from the HOME point. All exist-
ing data will be erased first. Make sure you have saved the 
existing survey first.

Load survey: Load a 
saved survey in from 
disk. The file must be 
a KML, SHP or Tiles* 
compatible file.

Save survey: Saves 
the current data set 
as a survey to disk. 
The file will be saved 
as a KML compatible 
file.

Click this button to 
exit the application.

The File types include KML,KMZ, SHP, PRJ and Tiles format respectively. KMZ is the default format you 
load and save your surveys in. SHP allows you to import data from an ESRI Shapefile and Tiles*  allow 
you to load local map data for use in wireless in regions without wireless communication.

If you go to File icon and then click 
on Load icon you will land on this im-
age. We will start with Load Project
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Loading Shape file in Foreground
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To demonstrate now a great feature of GIS360 we will upload those shape files to the cloud, to make 
those data accessable at any given moment. More about it in a Cloud part of this user manual.

After loading a desired map on 
the the screen pülease go to 
Tools icon

Chapter on page 59,  De-
scription of GIS360 Cloud 
– Mapping Services gives 
more details on setting 
up a cloud  

Choose from the list of three 
services a Cloud Server and then 
press Cloud  upload button

Now you will be asked if 
you wish to upload your 
data to the cloud, which 
you should answer with Yes

Web upload progress will be 
shown. Please have a patience, 
based on the size of your files 
the time taken to upload will 
vary, small files will upload in a 
few minutes large files will take 
much longer.

When finished you will see your new uploaded 
shape files in the list  when they appear in the list 
click on Yes.  The data uploaded is saved on the 
cloud and can be called at any time from this de-
vice or any other device which you or your associ-
ates are using in the field. More about it in Cloud 
section  of this user manual.
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Loading  already imported Shape file  (Foreground)  from Cloud 
to the field
If you are planing to work with a very large data sets it is highly recommended to import first your SHP 
data either over PC version or WM version of GIS360 and save them as foreground data, then simply up-
load them to a Cloud Server. More about it in a Cloud part of this user manual.

Under Tools go to Cloud From three options, chose 
Cloud Servers and select de-
sired files and press for each +

Now simply “load” all needed 
files to a lower section

Now you can first choose area 
. This will help you to load 
only the data needed in that 
particular moment. 

Now you are ready to down-
load data from the cloud to 
your unit. Simply  click on 
Soon after a new window will 
appear and confirm it with Yes

This message will appear if 
only if the schema of the data 
from the cloud are not identi-
cal with your correct schema.

A few seconds later the data 
stored on the cloud  will appear 
on your unit, ready to be used 
in the field.
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Loading Shape file in ENM
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Important Features: Importing Shape Files
Importing Shape Files: These files are generated by ArcGIS™, ArcPad™ and similar ESRI™ products.
Please see www.esri.com for details. This application needs two basic files to be available with extensions 
*.dbf (for attributes) and *.shp (for geometry). These files usually give no indication regarding the coordi-
nate system. You have to select the type from a conversion list to proceed. 

Importing Shape Files 1: Start Loading your SHP file by using the Load Survey button. Please note 
that both *.shp and its accompanying *.dbf file must reside in the same directory. This operation actually 
loads both files.

Importing Shape Files 2:  Select the file extension choice and pick the file you want to import. Then 
click Ok to load it.

Importing Shape Files 3: Select the way Shapefile™ have the coordinates. Note: The ‘datum’ can be 
altered in the Tools menu.

Importing Shape Files 4: Select the Primary field name from the list.  The field value from the se-
lected field will be used in Google Earth™ to identify the record being examined. If you used <Label 
as Record Index> then the index position in the file is used to identify the object. Click the tick mark 
to proceed.

Importing Shape Files :  Use 
File: Save Survey  to save the 
file as a KML file.
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Importing Shape Files: Double click the chosen filename from the saved directory to automatically load 
Google Earth™ with the data you have just saved.

Importing Shape Files: To view attributes, just click on the Primary Attribute in the list in Places to 
bring up the data.
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Edit menu
Item

Edit Attribute data: Allows at-
tribute data already collected 
by the application to be altered.  
Click to enable feature

Edit Attribute data: When enabled, 
please note it is not possible to 
‘drag’ the map. To re-enable the 
map drag, you must click this fea-
ture again to disable it.

Edit Attribute data: Click-
ing the tip of the pin-point 
show the attributes:

Edit Attribute data: Double Clicking the 
Name  or Value of Cause allows you to 
change the attributs:

Edit Attribute data: Double 
clicking a field with numeric 
values will display the keypad.

Edit menu: Stake-out icon

Edit menu: Stake-out 
valeu will be shown on 
the screen
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Edit menu

Edit Menu
Editing Tool/ Line editing

Point editing: Choose editing button and then tap 
on the point to be edited

Point editing: Choose the WALK button then 
press on the point (TREE) to be edited

Point editing: Choose this button
and tap on the new point

Point editing: As 
you can see, the TREE 
symbol
changes place and 
point editing is fin-
ished

Line editing:
Choose LINE to be
edited, and then 
the symbol for the 
line must be clicked, 
which is in the middle 
of the line it self.

Line editing:
Choose LINE to be
edited editing button 
and then press on the 
LINE to be edited
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Forward/Backward

Forward

New point

Accept/ Complete

Chose a point

Chose a line

Cancel

Zoom outZoom in

Press MINUS to 
delete one point 
on the LINE.
Choose the Point

As you can see, 
the point is not 
anymore
part of the LINE.

And the “new” changed 
LINE looks different now

Line editing: Choose
points to be added

Edit Menu
Line editing
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Edit Menu
Editing Tool/Line editing/Line extension

Line editing

Line extending: Choose
the last point on the line, choose 
new point and the line will be
extended
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Edit Menu
Editing Tool/ Parcel editing

Parcel editing: Choose 
the parcel to be edited

Parcel editing: Choose 
EDIT Item

Parcel editing: The GIS 
Table apears. Press the 
Walk Mode button Parcel editing: Zoom and Pan choos-

en parcel to fit your screen

Parcel editing: 
Press the Line tool
and choose the 
desired line
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Parcel editing: After select-
ing the proper line press + 
and select the new point to 
be added

Parcel editing: the new 
point has been added

Parcel editing: repeat the 
same procedure for all points 
involved
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Parcel editing: until your ed-
ited parcel doesn’t get a proper 
shape. When finished press YES

Parcel editing: to finalize the 
process press YES and your 
parcel is FIXED

Method menu: Editing tool/Parcel editing
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Walk Mode:  First you have to ensure 
that you have 2 points specified on your 
map, where one will be the anchor point 
of your construction and the other will 
be a directional node. One corner of your 
constructed  plan will be fixed at the first 
point and another corner will be fixed  in 
the direction of the other anchor point.

Walk Mode: A walk type item will be 
created by selecting this button. When 
new points are added to the walk de-
sign and accepted, a new Walk Mode 
(Special Polygon) Item will be created. 

Walk Mode: This is a turtle graphic type of walk where you 
move forward, left or right and specify the distance from 
your current position. To complete the walk polygon, there 
is a complete button which guarantees the walk polygon 
will be closed. The idea is to ensure that each internal an-
gle is always 0 degrees,90 or 270 degrees from the current 
direction.

Edit Menu
Walk Mode

Point  1 or 2

Point  2 or 1

Walk Mode: Press this symbol to enter 
the first distance

Walk Mode: Example – Define the Anchor Points 
with GNSS/GNSS
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Walk Mode: Example – Click 
the Walk button then add the 
distance to move in the cur-
rent direction -forward

Method menu: Walk mode

Zoom in Zoom out

Forward or backward

Forward

New point

Left button

Right button

Complete button

Choose a point

Choose a line

Cancel button
Area

Walk Mode: Example – Click 
the Walk button then add the 
distance to move in the cur-
rent direction -left

Walk Mode: Example – Continue the 
turtle graphics until you have most of the 
walls defined
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Method menu: Walk mode

Walk Mode: Example – 
Now click the Left but-
ton then add a new Walk 
distance to move in the 
new direction.

Walk Mode: Example – Continue 
the turtle graphics until you have 
most of the walls defined

Walk Mode: Example – Now 
you can follow your progress 
in building construction for 
example

Walk Mode: Example – Continue 
the turtle graphics until you have 
most of the walls defined
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Method menu: Walk mode

Walk Mode: Example – you are 
almost finished. Now you need only 
to eliminate the points not needed.

Walk Mode: Example – you are 
almost finished. now you need only 
to eliminate the points not needed.

Walk Mode: Example – if an important AREA is shown as well
Walk Mode: Example – you are 
finished

Walk Mode: Exam-
ple – you are almost 
finished. Just close 
the table
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Edit menu
Undo

Undo: Deletes the last graphical feature 
added along with the attribute data.

Undo: Clicking the button removes the 
last graphical feature added.

Edit menu
Delete

Delete:  Deletes the graphi-
cal feature along with the 
attribute data.

Delete:  Click the 
base of the Pin Point 

or Marker that you 
require to be deleted. 

This item will flash.

Delete:  The graphical feature will be re-
moved along with any attached attributes.

Delete:  If your ITEM is covered by this wîndow, 
just DRAG it away, then Click YES
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Delete:  Deleting areas and line 
items require you to point and 
select the base of the required 
marker

Delete:  By selecting Yes, 
the graphical feature is 
removed along  with any 
attached attributes.

Measure: Select the Measure icon. 
The measurement can be done clicking 
on the map or snaping to two known 
points.

Measure: Selecting the Measure icon  
again will erase the measured distance 
between two  points.

Edit menu
Measure
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Edit menu
Display coordinates

As for “Edit Menu: Ruler”, select the Ruler symbol, then double tap the 
point on the screen you wish to know the exact coordinates.

The coordinates are 
displayed. GIS360 can 
display Lat/Lon/Alt, 
or Grid coordinates. 
This can be defined 
in Tools/Grid.

Stakeout 
Calibration/Localization

After clicking on the Stakeout icon 
you will see on your sidplay your 
current GPS cursor and a big circle  
with a distance to the point.  This all 
depands on your current zoom level 

If you are using high zoom level, then you 
may see an arrow with a direction lince 
and a distance.

As soon as you come in range 
of 10 meters away from your 
desired point this window will 
appear, with all details

Stakeout
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You can stop the calibration at any 
given moment just pressing this icon. 

Calibration/Localization icon 
if you pressed localization icon before, now you 
will see a new window. Please enter under “Counts”  
choose number of epochs, usually we use 50

Calibration / localization

To start Calibration/Localiza-
tion process click on Start 
icon

When counting is finished 
click on yes

This feature you can use if you are 
standing on a known point with your 
GPS, but on the map screen your GPS 
cursor is away for some particular rea-
son. To “MOVE” your GPS cursor to be 
exactly above your known point you 
can use  our Calibration/Localization 
function.

Usually To get a coordinate list you 
can click on this icon 

Here you c an choose the type 
of your Data Base
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NAVCOM SF3040 Quick Start StarFire 

For Starfire it is important to allow two functions. Display the current license status and initialize 
StarFire with a ‘Quick Start’ position seeding. For StarFire Quickstart is important to keep in mind that 
Starfire uses  ITRF coordinates. Currently this is ITRF08. We use WGS84 datum internally in GIS360 . The 
driver instructs the NavCOM receiver to convert to WGS84 with the datum function. 
It will be necessary to provide methods for the user to select points or enter coordinates from the pro-
gram. In GIS360 we allow multiple methods for the user to input points. Primary our users are using 
GPS Average and Previously Stored Points. 

and if existing, list of coor-
dinates will appear in this 
window

If you change it to Survey Point 
for example and confirm with 
Yes

In Edit mode, click on Ruler 
icon

Then you will get this window and shoose 
following icon to start Quick Start Star Fire

After Quick Start Star Fire 
process has started, it usually 
takes 50 seconds to finished 
and if all OK you will see fol-
lowing message
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Collect Menu
The purpose of the Collect Menu is to define:
- What has to be measured
- How to measure, by GNSS, Total Station, Distance meter, Tape or manually

Click on the arrow to en-
able the Method Menu

Clicking on the schema will display 
the list of items that can be meas-
ured. This list can be defined individu-
ally (see chapter DataDesigner)

List of items that can be 
measures

Clicking on the arrow will 
display the measuring 
methods. 
These will be explained 
in the following pages bit 
more in details

Several methods are 
available to enter an 
object

Snap point

Pen

Enter coordinates

Cogo

Total station

Once the method is se-
lected, click                to start 
the 
measure

To end the measure, click 
on the green arrow
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Method Menu
Snap Point

Snap Point:  Allows you to glue a posi-
tion in your graphic construction onto 
a point of an existing item. If we already 
have these three linear objects, we may 
want to start at a used point for the next 
linear object.

Snap Point:  First, select your 
graphic type then select the Snap 
button. While this is selected, the 
closest survey point to the tapped 
point will be selected if it is within 
the search radius.

Tap Point:  Select this button 
to put the application into Tap 
Point  mode. This allows both 
tapping on the screen to se-
lect a new position and using 
the GNSS when it is enabled.

Method Menu
Tap Point

Tap Point:  When you tap a 
point or select an enabled 
GNSS position, this leaves a 
tap point in the survey area.
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Enter Point:  Highlight 
this text bar then key 
in the Easting value in 
metres (could possibly be 
US feet). Please note you 
can highlight Easting (E)  
Northing (N) Level (L) 
in any order and go back 
and edit them later until 
you finally click the Enter 
button or Cancel but-
ton to complete this data 
entry.

Enter Point:  Select this button 
to put the application into Enter 
Point  mode. This allows coor-
dinates to be added by Easting, 
Northing and Level (Altitude 
above Mean Sea Level).

Note:  You can only enter the Map 
coordinates as Easting, Northing and 
Level. Map coordinates are calculated 
from Latitude, Longitude and Altitude. 
This depends on the transformation 
and projection used which varies 
from country to country and the map 
system used there. You can change 
the projection/datum being used by 
reselecting it in the Tools Menu.

Method Menu
Enter Point coordinates

Please Note: In this version of the 
software, the Level is interpreted as the 
Altitude from Mean Sea Level .

Please Note: Due to space restric-
tions, it is not possible to show the 
Easting Northing and Level simulta-
neously with the Latitude Longitude 
and Altitude on the Mobile PC plat-
form. However you can see both sets 
of coordinates on a PC.

Once the method is selected, 
click                to start the coor-
dinate entering

and a description After all your at-
tributes are entered 
please confirm it with 
Yes

Now you can see your new 
entered point on the map

Now, depending of your 
schema and your attrib-
utes, you will need to 
enter maybe your point 
number  and..

After entering all three coordinates you 
will see this message on the screen
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COGO with gestures recognition
There are several possibilities to enter data, for instance manually by using tape or distancemeter, or 
with a distancemeter and Bluetooth connection. We will now look in details at the latter method.
First step: enable Bluetooth on the GRS1 in the Bluetooth Manager (as example only). Once enabled, the 
blue Bluetooth led at the bottom of the  Topcon GRS1 will light up.

First we need to pair the distancemeter with the device.
Also you will need to Software “Disto Transfer”  from Leica in case you’re using a Disto with Bluetooth 
(http://ptd.leica-geosystems.com/en/Support-Downloads_6598.htm?cid=12799&linkid=QMNH). .

Go to the Bluetooth 
menu in Windows 
Mobile

COGO: Using a Laser

Click “Add new device”. Make sure to have activated 
Bluetooth on both the Disto 
and the handheld device. 
The system is looking for 
Bluetooth devices

The Disto has been detected. 
Select it and click “Next”

Enter the passcode (this code is 
often either 0000, 1111, or 1234)

The Disto has been connected
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COGO: Using a laser

It is now visible in the list. 
Now click on “Mode”

Activate Serial Port, click Save Click “New Outgoing Port”

Click “Next”

Choose the correct port. You might 
have to try until the system doesn’t 
display any error messages. This port 
is different for each device.

Example of an error message

The correct port has been set 
(here COM4)

Once the settings are correct, 
the DISTO will appear on your 
screen

You can test the transmission by 
measuring a point and pressing the 
Bluetooth button (Disto D8) for trans-
mission. The measure shall appear as 
in the screen.
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COGO: Using a laser

Start GIS360 once the connection 
is established

Select now the COGO tools

Select the Cogo tools. Draw a circle around your 
first point, the next screen 
will appear automatically

you can enter the values by hand 
or by pressing the Bluetooth but-
ton on your Disto to automatically 
enter the measure

The first circle appears on screen 
with the right diameter

Draw a second circle for 
the second point

The values can be entered as for 
the first circle

The 2 circles no appear on screen, 
with intersections clear and visible

Select the snap tool
Click on the intersection 
that you wish to register as 
your point
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COGO: Using a laser

GIS360 will ask you now for the other attributes that you have set up 
for this point

You probably wish to have the 
point only and want to delete the 
construction. Click on the Edit 
Menu, then select delete

Here you only delete the 
constructions

The point now appears with its 
attributes, but without the con-
structions

You can use the CAD tools to draw a line or a polyline

We want to draw a line 
between these 2 points

Select the Cogo tools, then select 
the line

Cogo and line are selected
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Draw a line on your screen 
with your pen between 
the two points

GIS360 will draw this line precisely

COGO: Bearing and Distance

Do perform Bearing and Distance 
choose two points on the map and  
draw  with your pen a line up and 
down between the two points.

Like you can see this doesn’t 
need to be a straight line 

If you wish you can use 
drawn angle as Zero Bearing. 
Click on YES if so

Now enter Bearing angle..
and desired Distance, either 
manually or with the help 
of Laser distance meter

and your new point will be 
displayed on the map screen

Remark: CAD menu 
is selected , from 
bottom of Schema
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COGO: Chain and Offset

To make a Chain and Offset just 
draw such line between two points

and you will be asked to put in 
the Chain distance and then..

the offset distance as well

As a result you will see new 
point on the map

Now you need to change 
Method from COGO to Snap

and your point will be 
properly mark on the 
screen

COGO: Line Offset/Parallel

To be able to make a parallel to an existing line or even a parallel 
between two points, you need to drawn a  two lines with a pen, 
from first to second point and again from first to a second point

So now enter the desired offset and 
you will see the result on the screen
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COGO: Line intersection-Simple

If you wish to make an intersection 
point then you need to have either 4 
points or two already existing lines

Like learned before draw a line 
between first to points. New 
straight line will be the result

and then draw a second line 
between second two points

New straight line will be 
the result and you will get a 
intersection point as well

Now just change from 
COGO Method to a snap 

And click with the pen on 
the intersection point it self

COGO: Line intersection-Multiple

To do more complex intersections is 
very easy. For example if you have two 
more points to be used then..

Draw a line between first to points. New straight line will be the 
result and an new intersection point as well
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Drawn a line with pen be-
tween two new points

Line is straight and now.. Drawn a second time a line 
starting from the fist point 
again. This will provoke a..

New window in which you 
need to enter a offset. If you 
need a new line top be left 
from your line enter the offset 
distance like in our case with (-)

Second line will appear on 
the map. Now press + to 
start for example Parcel and 

Start snapping from first 
to last point and close it 
with Yes

Final product will appear on 
the map 
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GNSS Method

GNSS Accept: Click this button when-
ever you need to record a position at 
the GNSS cursor.

GNSS Accept: For instance if the Graphics was 
set to Parcel mode, a trail would be created 
joining consecutive Accepted GNSS points.

GNSS Method : Make sure you have got 
the GNSS device connected to the cor-
rect port. Instructions are under Tools 
Menu: GNSS Port.

GNSS Enable: Click this button to enable 
the GNSS.

GNSS setup: Please note this version of the 
application assumes that the GNSS device 
will automatically transmit NMEA instructions 
at a baud rate of 115’000, com 7, Port 7, 1 
start bit, 8 data bits, 1 stop bits and no parity. 
If you use Bluetooth ™ these values are not 
important. 

GNSS Enabled: 
The current 
GNSS position 
is shown by this 
cursor:

GNSS Enabled: Select your Graph-
ics Mode  to create new objects 
from selected points using GNSS 
Method.
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Graphics Menu CAD

Single Point Mode: A single point 
item will be created in this mode.

Linear Mode: A trail of 
points will be created 
indicating a pathway or 
boundary of some type.

Area Mode: A trail 
of points will be cre-
ated that will always 
be a closed pathway or 
boundary of some type.

Please note: Once you 
select a mode, it is only 
valid for the lifespan of 
creating the new graph-
ic item.  To use it again 
to create another item, 
you have to reselect the 
mode in question, by 
pressing at big PLUS.

After pressing the single point item, a 
new sub menu will appear with the choice 
of Single Point Mode, Linear Mode and 
Area Mode

Graphics: If accepted, you will be offered the list of attributes 
available for that Graphics Mode.

Note: Single Point Mode items do not require closure, they are automatically ac-
cepted but may be removed later using Edit: Undo.

Graphics: When a new Graphics Item has been 
constructed, you can Accept the data or Cancel it.
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Graphics Menu: GIS
Single Point Mode: A single point item will be created by 
selecting this button.  When a new point is added to the 
map sheet, a new Pin Point symbol will be created. 

Single Point Mode:  Select your position us-
ing tap point, snap point, enter point or GNSS 
point. The next screen frame to be shown is 
the one where you must choose which GIS. If 
you choose <CAD> the feature will not have 
any GIS fields attached to it.

Note: The style of these entries can be set in the Form Generator which 
creates Schema (*.XSD) files that control the way data is requested and 
edited.

Graphics: Finally the table of the 
chosen database can be populated 
with relevant data. if the Accept 
button is clicked otherwise Cancel 
bypasses this operation.

Graphics Menu: GIS Single Point

Single Point Mode: Populate the 
fields according to relevant values 
then click the tick mark to accept the 
entries.

Single Point Mode: After refreshing the 
map area, the data pin point should ap-
pear.
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Graphics Menu: GIS Area Mode

GIS Mode: Tapping in this window 
will list all options available:

GIS Mode: if you wish to 
survey a building, press 
Building.

Note: The style of these entries can be 
set in the DataDesigner which creates 
Schema (*.XSD) files that control the 
way data is requested and edited. For 
more details, see chapter DataDesigner.

Measure your points with the appropriate method, then confirm with 
the green button

GIS360 will guide you to enter the values you have set up for 
the chosen item.
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Once all values entered, the item appears 
on screen with all its attributes

Linear Mode: A linear type item will be created by selecting this 
button.  When new points are added to the map sheet and accept-
ed, a new Linear Mode Item will be created. 

Linear Mode: Use the point 
method you have selected (can 
be altered any time during the 
operation in this mode), to trace 
out the path of this linear object. 
Use the closure buttons to com-
plete or cancel the polyline.

Linear Mode: Finally, the linear item (polyline) will 
be shown along with a marker. This marker is used to 
identify the item and allow the attributes to edited  or 
viewed in the future.  Also the entire linear item and 
attributes may be removed (see Edit Menu: Delete for 
details).

Note: The style of these entries can be set in the 
DataDesigner which creates Schema (*.XSD) files 
that control the way data is requested and edited.

Accept buttonCancel button

Graphics Menu: Linear Mode

By clicking accept, if you have 
selected a database, the next 
screen will pop up
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Graphics Menu: GIS Area Mode

All values can be entered or skipped. For 
each field, either a list menu, or a key-
board, or a numeric pad will pop up.

Clicking into the “Owner” 
field will bring the keyboard 
in this case.

Clicking into the “Parcel Nr” 
field will bring the numeric 
board in this case.

Clicking into the “Use” field dis-
plays a pulldown menu.

All values are now entered, only the 
image is missing.
Rremember you don’t have to enter 
all values, you can skip some of them 
or skip them all.If your device is equiped with a camera, you can simply double click the “Photo Field”

“Click” to take the picture
You can verify that the picture corre-
sponds to your expectations, then “Exit” to 
register and exit this mode
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Map Mode

Map Mode: Clicking this button will produce a change 
in the type of background map being used.
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Configuration: Clicking this button will 
allow you to view the available con-
figuration properties and the ability to 
store some local maps for use in wireless 
shadow regions*.

You can choose the back-
ground color. When  click-
ing in the  area from back-
ground color, you will be 
given the choice of colors

Tools Menu
General

The double Tab function allows the 
user to place to point, to zoom , or to 
navigate to

Autosave

You can define the background 
color by clicking in that field.
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Tools Menu
Key

In previous pages, on the beginning of this user manual, we already described the key installing/activa-
tion process. Here we would like only to point out the fact that in the same menu you can change the 
language version of GIS360. 
Also for units with very lower performance and shortage on Main RAM user can display memory avail-
able, just to be on the safe side if he has enough “power” to run the GIS360.

Tools Menu
Data

Main Data Configuration screen
The black arrows help for the naviga-
tion through your attributes, if you 
have more than 5 or 6 attributes
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Tools menu: Data

Define point sizeDefine the line thickness. When 
clicking on the attribute, you 
will be asked to choose the 
desired colour

Or Full Draw Zoom Level

Choose the colour and confirm

choose the opacity or 
transparency

Note: The style of these entries can be 
set in the DataDesigner which creates 
Schema (*.XSD) files that control the way 
data is requested and edited. For more 
details, see chapter DataDesigner.
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Choose the colour and confirm

Tools Menu
Map/ Load DXF/DWG 

To load ENM tiles, click “Select ENM”

You can now choose your 
file or browse another folder 
and select the file you in-
tend to use.

Your chosen file appears on 
the screen.

Your zoomed file appears 
on the screen.

If you decide to zoom it bit 
more, this may take some 
time, depending on the size 
of your DFX/DWG file. 

If you wish to change back-
groud map just press the 
Maps icon, once or twice

Desired file is listed now. 
confirm with Yes
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Tools Menu
Map/ Create background map with DXF/DWG  on PC
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Tools menu
Grid
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Tools menu
Devices
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Tools menu
GPS



84 Carlson GIS360

Tools menu
eCom

GIS360 can be configured to send periodical emails with the saved field-
work. This feature allows the office to be precisely informed about the 
work progress.

Click on the arrow next to “Email Comms” to see the list of possibilites

To set Name, Adress and 
Email of addressee, tap 
in the green box to show 
the keypad
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Enter the corresponding 
information

Enter the corresponding in-
formation. Remark: Subject 
can’t be empty.

Enter all necessary informa-
tion for “To”

Enter all necessary informa-
tion for “From” including your 
password for email account



86 Carlson GIS360

To test the Ecoms settings, will shall 
save the work in order to send the 
file

Enter Name, Type of file, 
Folder and Location, then 
save

If this file is already existing, 
a pop up message will ask if 
you want to replace this file, 
if yes, your file will be saved

Upon saving, a message 
confirming that the file 
shall be sent

Now the file is shown in the 
“Attachment”

If you have set the Ecoms on “Individual Record”, the 
data will be sent as soon as you close any GIS object
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If you have set the Ecoms on 
“Individual Record”, the data 
will appear as in the next 
screen Confirming with the green ar-

row will send the file by email

Tools menu
Cloud-using your own cloud server (Amazon)

To start Cloud go to Tools 
and then cloud

First you need to enter your 
cloud key

click on + and enter you  ac-
cess and secret key

After this both keys are en-
tered please press Yes
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People have been getting a bit confused about the cloud – Map services that are available in GIS360 so 
we hope that this document will offer an explanation. The “Cloud” is just a server and you can put (and 
get) any data up there just like it was a hard disk on your computer. Instead of having your own server 
most people define “Cloud” as meaning that you are using a Cloud service, ie you have space and rights 
to use a server that someone else maintains. For example Amazon offers such a service for GIS360 users 
just as Amazon does for ESRI.

When you take the “Cloud” and add a geographically aware database, then you have a GIS in the Cloud. 
This Cloud-GIS can now respond to geographic requests for maps and data, and using its database it can 
respond in a variety of ways.

Cloud – GIS services can send out both Raster and Vector data. Some people use the terms “Maps” and 
“Data”, to mean Raster and Vector, but that isn’t strictly correct. Sometimes a Cloud published map can be 
vector data. The situation gets even more confused because most GIS servers can publish Vector data via 
the Cloud as a Raster map. So for the moment lets just say that Maps are Raster and Data is Vector.
Cloud – GIS’s can securely publish maps and data for internal or individual use, or they can publish the 
data so it can be used by millions.

ESRI published Map Services

ESRI themselves publish map services for all of their customers to access. This is the equivalent to a Goog-
le Map service but focused on ESRI customers. The data is Raster data. These are the map servers that you 
will find in GIS360 in the maps selection pull down listbox.
For example “ARCGIS_World_Topo_Map” in GIS360 will produce maps like this.

	 This direct ESRI mapping can be accessed in GIS360 right now.

Description of GIS360 Cloud – Mapping Services.
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ESRI publishes User WMS maps
ESRI users can also publish their own map services. It’s like having your own little Google Earth but with 
your data in it. WMS (Web Map Service) is an open standard supported by most GIS systems. ESRI users 
can take their data and easily publish it as a WMS service. Here are the instructions to do so http://web-
help.esri.com/arcgisserver/9.3/java/index.htm#tutorial_wms_service.htm

If a user has an MXD file then all you do is load the MXD and publish it. It’s pretty simple.

The data that goes into that service can be raster or vector but what comes out will be a complete map in 
Raster format. This is useful if you want your users to be able to see the data but not change it.

When the ArcGIS user publishes his data ArcGIS generates a web address. The user then takes that ad-
dress and gives it to GIS360 by placing it in a file (in the Reference folder) called WMSservers.txt.

The file lists the WMS servers. All that’s needed is to use Notepad to type a name on one line and then 
put the address on the next line down. The names will then appear in the list of map choices in GIS360.

The reason this is done in a separate file is that normally this is done by the ArcGIS system administrator 
because he is the one who generated the address. It’s not something that will change on a daily basis 
and web addresses tend to confuse users.

Below is a USGS map published by an ArcGIS user.

This capability is in GIS360 right now.
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ESRI Publishes WFS data
ESRI users can also publish data as WFS data. WFS (Web Feature Services) are vector data and are actu-
ally real live data straight from the ArcGIS database. Here are instructions to set it up. http://webhelp.esri.
com/arcgisserver/9.3/java/index.htm#tutorial_wfst_service.htm

The terminology here is important, when you say that you are publishing WFS you say that it is data, you 
don’t normally call it a map. Although it could be used to make one.

There are two types of WFS... WFS and WFS-T . The “T” means transactional or in other words I can send 
data directly to and modify the database directly in the field. If you just want to look at data in the field 
then you can publish plain WFS.

This is also in GIS360

NON – ESRI solutions

ESRI isn’t the only company doing this type of thing. Remember MWS and WFS are open standards. Since 
ESRI fully support WMS and WFS it isn’t really important but it would have been nice.

LizardTech

LizardTech makes the compression engine Mr.SID used by many in the United States. They no longer 
support Windows Mobile BUT I have checked and we can connect directly to LizardTech server product 
and download Mr. SID data directly. This means that a Mr. SID user needs to publish their data and then 
GIS360 can use it just like any other map service. (It’s also cool because our GIS360 cashing and tiling 
system works with it perfectly)
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Below is a picture of some data that Mr. Sid sent us of New Jersey.

GeoServer

GEoServer is an open source (FREE!!!) server program that can publish both WMS and WFS data. GIS360 is 
compatible with it. We found it very useful when users wanted to load their own Raster data into GIS360. 
It supports most Raster formats and it was easy to load the files into Geoserver and setup a Map Service. 
Then GIS360 gets the users data just like it was from Google but it’s the users own data.

Amazon

Amazon is one of the world leaders in cloud technology. ESRI themselves use it. Amazon produce a vari-
ety of products that developers can use to make products but Amazon isn’t really an end user product, 
they make tools for others.

What we have done is to use their tools to make our own cloud system. It has a couple of big advan-
tages. The biggest one is that we can setup a customer with a Cloud server in about 10 minutes and he 
can have his data up there in 15 minutes. It’s very easy to use and we don’t have to know our way around 
ArcGIS server, which is not a simple (or cheap)process.

In a way this can be thought of as the GIS360 cloud.

There are two types of Amazon based Cloud services in GIS360. Cloud Projects and Cloud Servers.

Amazon – GIS360 - Cloud Projects

Cloud Projects are online storage for Project GIS360 project files. These contain everything a user might 
need in the field, data, maps, settings, everything all ready to go. When a user select a Cloud Project the 
project file will download from the cloud. Then it will automatically unzip and start right up where the 
work needs to be done. All settings are made automatically. Cloud Projects are also a great way to do 
demos because it allows you to bounce back and forth to different parts of the world and different data-
sets with just a single click of the mouse.
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Amazon – GIS360 Cloud Servers
This is actually what we use the most. What it does is store GIS360 data in the Amazon Cloud.
When you setup a datatype in the GIS360 you can set it to be Cloud Compatible. Any data item that is 
cloud compatible (or shape file) can be loaded into the cloud. Then GIS360 will automatically send new 
data items to the cloud. GIS360 can also get small areas of data, edit them and send them back.

Below is an example of Vector GIS data using the GIS360 Cloud servers.

One big advantage of working with the GIS360 Cloud servers (and WFS servers) is that you can work with 
very large datasets. This is because GIS360 will only download the data near your position and only upload 
those items that have been changed or added. So a total dataset with millions of records can easily be dealt 
with one small local area at a time. This also makes it easy for multiple users to work on the same data.

Carlson Cloud Explorer

Both Cloud Projects and Cloud Servers can work with the Carlson Cloud Explorer. This started life as a 
useful debugging tool for checking on the current status of the cloud.

But it quickly became apparent that it was useful. Especially with the built in link to Google Earth. So for 
example it can find all the survey data done by a certain surveyor and plot in in Google Earth. It can also 
give you a view of your currently loaded Project files.
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Tools Menu : Cloud functionality
https://www.amazon.com/ap/signin?openid.assoc_handle=aws&openid.return_to=https://portal.
aws.amazon.com/gp/aws/developer/registration/index.html&openid.mode=checkid_setup&openid.
ns=http://specs.openid.net/auth/2.0&openid.identity=http://specs.openid.net/auth/2.0/identifier_
select&openid.claimed_id=http://specs.openid.net/auth/2.0/identifier_select&action=&disableCorpSig
nUp=&clientContext=&marketPlaceId=&poolName=&authCookies=&pageId=aws.ssop&siteState=&ac
countStatusPolicy=P1&sso=&openid.pape.preferred_auth_policies=MultifactorPhysical&openid.pape.
max_auth_age=3600&openid.ns.pape=http://specs.openid.net/extensions/pape/1.0&server=/ap/signin?
ie=UTF8&accountPoolAlias=&forceMobileApp=0&forceMobileLayout=0

To sign up to the amazon 
cloud go to the following 
link and follow instructions
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ggggg
cttrrrrr
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Tools menu
Map configuration When clicking on “Map brightness”, you will be able to set the 

value anywhere from 0 to 0.8. This function is essential, should the 
map be too light or too dark.

After brightness application

Before brightness application

Show Grid:  Show or Hide the 
grid lines on the screen area.

You can also choose the grid thickness

Tools Menu
Grid configuration

Choose appropriate colour and 
confirm with OK

By clicking on grid color, you can 
choose the convenient color for 
your grid, as displayed in the next 
image
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Tools menu: Grid configuration

If you need to change 
the Grid system, click on 
“Choose  Grid” to display the 
list of available grids:

you have two choices, either 
UTM settings or preset projec-
tions

For UTM you need to sellect 
appropriate Zone and Band

Band you can choose either  
based on it’s appropriate letter 
or just simple North or South 
Hemisphere

Other option is to choose 
your country directly 

List of the countries is big, 
so scrolling up and down 
will help you to find it easy

Maybe you need to wait few 
seconds

Now you need to choose your 
particular state.

Even within the state now 
you maybe need to choose 
particular preset
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Important features: Saved

Saved data: When you save data to disk, it will be in a KML/KMZ format,like mentioned before . This 
format is compatible with being shown on Google Earth ™ and other Google Map ™ applications. For 
instance saving the data as shown in this example...

(map drawn on the PC version)

...will display like this on Google Earth ™

Saved attributes: Data with attributes will be saved in KML format. This format is compatible with Google 
Earth ™ and other Google Map ™ applications. For instance saving the data as shown in this example...
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Important Features: Operating in a wireless blocked re-
gion*
Please note: This facility allows you to use your mobile PC to collect data in areas without wireless cov-
erage. To enable this functionality, you must have a temporary background Tiles file previously stored 
using: Tools Menu: Map Configuration.

An Example region where 
no wireless communica-
tions is possible.

Select the correct folder and Tiles 
type then load in the background 
fragment

The area of interest will ap-
pear centralised on the Tiles 
files Home Marker.

Zoom into a working level. Zoom further, alter to satellite images for 
example, then load in your previous un-
finished survey for continued updating.
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Datacollection for Postprocessing

Click on the “Tools Menu” For Base station data, choose “Ref log”

For rover data, choose “Rov log”

Click on “Ref log” to start sav-
ing base station data for post 
processing

Click “Start” If you wish to start collecting 
and saving data, click “Yes”

When pressing “Enter ENL”, you can 
enter the base station coordinates 
for easting, northing and level

Location of data storage
Click “OK” At the end of the working day, 

press “Stop”
Confirm with “Yes” if you really wish to stop
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You want to stop: Click “Yes” File location: click “OK”

Press “correct”

Note: it will be important to 
place the base station data 
into the same location as the 
rover data.

Postprocessing: GNSS + VRS Options

GNSS options allow the user to define the 
satellite constellation and to increase the 
postprocessing accuracy.

VRS options allow to define 
the login parameters to the 
VRS network
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Datacollection for Postprocessing: Rover

Click on “Rov log” to start 
saving rover data for post 
processing

Click “Yes” Location of data storage

If you wish to stop the registra-
tion of postprocessing data for 
the rover, go to: Tools

Click “Rov stop”

Confirm that you wish to stop 
by clicking “Yes”

Then go to GPS

Here you have the information regarding 
the storage location of your rover data

Note: it is important that you 
copy your rover postprocess-
ing files into the same loca-
tion as your base station 
postprocessing data



104 Carlson GIS360

Postprocessing: Base + Rover Data

Look for the directory where 
your GIS360 PC version is in-
stalled.

To start the postprocessing pro-
gram, click on the executive file 
“GIS360PC_corrections”

This is the Postprocessing 
program window

The Correction engine will default to the recommended settings so most of these options can be ig-
nored.  However the most critical is the Epochs selector which is the number of Epochs to be averaged 
together to form the final position on each point.  If you stayed on the point for 20 seconds each time 
then select 20 seconds in the Epochs.  You may then continue by pressing OK at the bottom of the Op-
tions menu.  The other options are as follows….

Filter: Single difference filtering tends to work best for most data sets.  

Elevation Mask:  This can be adjusted to ignore satellites below a certain elevation.  

Correction Method: Single Difference is a Hatch filter and works best for mast cases.  

Show Correction Rover Links:  On the plot it will show the link between the point where the button was 
pressed and the corrected point

... choose the Reference File you 
want to apply postprocessing to

Look for your reference 
files (.ref ) by pressing here
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... choose also the Rover File you want to apply postprocessing to

Look for your rover files (.rov)...

Once you have your rover and 
reference files, click on Correct 
Data This is the confirmation of your saved data, click ok

To see the map of your raw 
data, click on map

On this map you can see how your Rover and Base 
data look like. These are pure 1 second data. Blue 
dots are Topcon values and Crosses are corrections.
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Postprocessing: Base + Rover Data

With the + and - you can zoom in and 
out to see the map of your raw data. 

To end this view, simply click on X 
The same applies to closing the postprocess-
ing program

In the GIS360 PC version, click on the OPEN 
FILE button and look for your kml files, then 
select the one you wish to process

Important Note: Your Post Processed ROV file 
has been saved in the directory “Reference” and 
has a .COR extension.

After opening your KML file, this is your raw 
KML data in GIS360, as surveyed in the field. 
Now you want to apply the postprocessing 
corrections

Click on “Tools” to see the following “dialog box”, 
where you click on “correct”
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You can now see that the corrected points 
have a different color. In this example only 
6 points have been surveyed, and we see 6 
corrections.

You can now choose the correction file (exten-
tion .cor) and click “open”

Here an example with a Polygon, following the same procedure as previously for single points. Without 
going as much in details as for single points.

Start the rover and reference 
files

Map view of raw data

View of your field KML Field data Here you can import COR file.
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Postprocessing: Base + Rover Data

Here we see that the corrections have worked 
and  that “old” points moved to the new posi-
tions.

This image displays that the corrections have 
worked and  that “old” points moved to the 
new positions, but with aerial image in the 
background.

Don’t forget to save your “NEW” KML file. We sug-
est to use the same name as the original KML, but 
adding and a “sufix” like a ,b or c.
Now you can export your NEW KML file into 
Google Earth.
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press here to change GIS Database choose your preferable GIS Database, in our case 
Survey Point

If you need to enter coordinate 
for your points please press here

and choose a keyboard option

enter desired E,N and L values, by pressing to E,N,L

How to use Total Station with GIS360

message about the WGS84 conver-
sion will appear and you can enter 
the point name and Description entered coordinates will then appear on the map screen
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BLUETOOTH settings

In GIS360 you have two ways to define communication 
with your Total Station. One over PC internal BT manager 
and other over GIS360 directly. If your total Station is not 
listed you need to press “Add a Device”

As soon as your unit appears 
in the list click on it and press 
Next

enter when requested pairing code 
in normal case 0000

wait some time and then you 
should get this message

new icon for your Total Station will appear, and 
press your pen on this symbol to get following  and 
choose properties

and now your com port is visible
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Other way of setting  proper RS232 com port will be described bit later in this manual

now, we need to set up our Total Station, so please 
press first Tools button, then you will get this new 
window and please press Total Station icon

choose please your Total 
Station model, in our case 
R6

choose here your desired 
brand, in our case Stonex

then you will be asked to chose 
EDM type, and if you wish to 
activate  laser pointer  

your final choice 
could look like in 
this

now please change from Bluetooth to Serial  Port

now please change COM port to 
yout appropriate one

in our case it is COM58

here is clear that we are using 
RS232 COM port

Now we will “play” with other option and this is 
to use BT interface directly in GIS360, without 
need to use BT Manager from the native OS, in 
our case Win7. Please press “Search” button now

GIS360 is looking now 
for all units in your sur-
rounding
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From the list chose the unit of 
your choice

now you only need to press OK this will bring you back to this 
window and now only press green 
YES button

you will see that not 
only Total Station 
icon changed on 
the top menu it also 
changed in the main 
menu. This is your 
Total Station Trigger 
button

so now press the Tools 
icon to start you station-
ing process. and you will 
see that new window 
will apear, so please 
press on Total St. icon 
and now new window 
will open

to enter coordinate 
of your known 
point press here

this will bring you back to 
this window and no only 
press green YES button

Now we need to change from GPS survey to Total Station survey. So 
please press this icon (it can be any of those 6 icons) and then please 
chose total station icon
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message is appearing to 
click on TS position, so after 
clicking on your point you 
will see your coordinates

to enter Total Station 
height press here and to 
enter Prism height press 
here

if on other hand you wish 
to chose from the list of 
your imported or surveyed 
points press this icon

then will prompt new win-
dow where you can chose 
which type of the point you 
are looking for
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you can have up to 5 refer-
ence points, so now press 1	

to enter coordinate of 
your known point press 
here

message is appearing to 
click on TS position, so after 
clicking on your point you 
will see your coordinates

to enter Prism height press 
here

to start measurement to your 
reference point now press 
this button and you will see 
this window coming

meassured angles and distance 
will appear on the screen

and first reference point is 
finished

if you had finished your sta-
tionning you need to press 
green Yes icon and you will 
go back to main map screen
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so no you see your orien-
tation, in our case to one 
known point, but it can be 
to five max.
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Free stationing
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Using a Cable Detection device 
with GIS360 
Saving a Map Cache  

Frequently before starting to use the field data collection 
system you need to know how to save maps incase you 
don’t have mobile phone coverage on your site. It is best to 
do this on the office version of GIS360 and copy the cache 
to your field system.  

1.	 Start GIS360 on your PC.

When GIS360 starts it will always put your Home position in 
the centre of the screen with a home marker.  

2.	 Move the Home marker to the centre of the area 
that you want to save.  

The home marker can easily be moved by making sure that the area that you want to move it to is on the 
screen. Go to the Tools Menu and select “Home Position” . You will be prompted to tap the screen at the  
exact position you want to move the home position to. The Cache is always saved around the home posi-
tion so that’s why we had to move it first. 

3.	 Save your Cache

To save your cache you go to the “Tools Menu” and then “Map Cache” .

The Area size is the size of the Cache to save. This is measured in meters across. Select the required size. 
Remember that it will save all the maps and aerial photos at all resolutions so don’t make the size to big. 
Then press “Save Local Cache”, enter the name, and then wait till its completed. At completion you will be 
prompted “Do you want to use Tiles now?” answer yes and zoom in to take a look.  

4.	 Copy the Tiles file to the GNSS.  

Always put Tile files into the MyDocuments subdirectory of the GNSS unit.

Pairing your Cable Detector with your GNSS 

Before you start GIS360 you must make sure that your Cable Detector is paired with the GNSS. To do this 
you must use the Bluetooth software on the GNSS unit and then make the connection with the Cable 
Detector.



119GIS & GNSS map creation tools

Using a cable detection device with GIS360

Once paired then you should not have to do this again. The key outcome of the pairing is that the Blue-
tooth driver has given the Cable Detector a COM port number. You must know that number to setup 
GIS360. Different Cable Detectors might be given different COM ports so please be careful.  

Setting Up your Cable Detector in GIS360 

When GIS360 is running you must setup the Cable Detector by going to the “Tools Menu” and then 
“ports”. Then pressing the sensors Tab on the Connections dialog will bring up the Sensors selection. 

Set the SENSOR type to Depth Sensor (Cable Detection Unit) and then the Correct COM port from the 
pairing.  Then set the Sensor Baud Rate to 9600 (The default setting for the cable detection unit) 

These Settings will be saved to disk and will not need to be re-entered again as long as you are using the 
same Cable Detector or the same COM port.  

Using GIS360 with a Cable Detector 

1.	 Start GIS360 Mobile 

You will then be prompted with a splash screen, followed by a couple of quick questions. The first is “Load 
Mapping From”, either you can select Internet if your GNSS has an Internet connection or you can select 
one of the Map Caches that you downloaded earlier.  
Select the Map Cache and press OK.  

Then you will be asked if you want to load an existing dataset. Just press OK to start a new set.  

You will now see your map on the screen.  
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Using a cable detection device with GIS360

2.	 Zooming and Panning 

Pan - Is always on. Just touch the screen and drag with the pen.  

Zoom In and Out - Is done with the scroll bar on the right of the screen. Press the + button to Zoom In 
and the – button to Zoom Out.  

Map or Aerial Photo - You can change from viewing a Map to Viewing the Aerial Photography by pressing 
the “Map Menu”.

3.	 Using GNSS 

At the Lower Left of the screen are two GNSS buttons.  The GNSS On/Off button will turn the GNSS on 
and off. 
 If the Icon has a red line through it then the GNSS is OFF.  Clicking the button will turn the GNSS on.  
When this happens the GNSS cursor will appear on the screen. 

This cursor will move with the GNSS and if you move off of the screen, it will always centre again the map 

to your position. The GNSS Accept button will mark a GNSS reading on the map. This is used if you want 

to draw things on the map. If you are using a Cable Detector however then this will not be needed since 
pressing the Log button on the detector automatically does the same function. 

4.	 Logging Detector Data 

Logging data from the Detector is very easy.  When you turn the detector on by pressing the switch on 
the handle the GIS360 system will start to beep. This means that data is coming in from the detector and 
that the Bluetooth connection is functioning correctly. Sometimes you might have to wait for 5 or 10 
seconds for the beeping to start. If it does not beep them please check the Bluetooth settings, especially 
the paired COM port setting.  

If GIS360 is beeping and you have a GNSS cursor on the screen then press the LOG button on the detec-
tor.
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GIS360 will then save a Cable Detector record and a yellow “Pin” will appear on your map. 

Using a cable detection device with GIS360

5.	 Seeing and editing your data.  

Once Cable Detection readings have been placed on the map in the form of Yellow “Pins” you can see and 

edit the attributes by clicking in the “Edit Menu”, selecting the pen and taping on the pin on the screen.       

You can then edit and view the data. Press the green button to confirm and go back to the map.

6.	 Saving your data and Viewing in Google Earth.  

The save your data go to the “File Menu” and choose save.

When prompted enter the file name, we recommend that you always save into the MyDocuments subdi-
rectory. This will save in the KML format.  
Copy your saved KML file 
across to your desktop sys-
tem and then double click 
on the file in explorer.  
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Using a cable detection device with GIS360- CScope Interface CScope Interface

Configuration

The first step required is to perform a Bluetooth pairing with the computer and the Cscope detector.  
This will vary according to mobile computer platform and should be covered in the manufacturer’s 
documentation.  At the end of the pairing process a Com port should have been assigned (e.g. COM0, 
COM22 etc.).  This Com Port value will be needed when configuring GIS360.

One the pairing has been completed, GIS360 can be started.  In GIS360 go to Tools> Devices, and click 
on the Sensor button. 

This will lead to the following form for selection on the sensor model…

Select Model as Cscope, Set the Port to the Bluetooth Com port as configured at the start. Set Baud 
Rate to 9600. Click on the Green Tick to confirm the selections.

Using Cscope within GIS360

When GIS360 is running and Cscope measurements are required it will be necessary to manually start 
communications.  To do this go to Tools>Devices and click on the sensor “Start/Stop” button.

This will lead to the following form which is used to control communications…

From left to right the buttons 
are as follows:
Start communication
Stop communication
Auto-start communication
OK (Green tick)
There is also an indicator at 
the top of the form which 
gives a visual display of in-
coming data.
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Note: For the Cscope it is recommended to always use the “Auto” button to connect to the device.  In 
practice some Bluetooth interfaces may not reliably connect at the first attempt, and the Auto-start but-
ton will automatically retry the connection in the absence of incoming data.

Set the Cscope to the required measurement mode and then ensure the Cscope is ON, preferably with 
a strap around the On/Off trigger to ensure the device stays switched-on.  Click on the Auto button and 
wait for the indicator at the top of the form to start showing a changing green bar.  When the indicator is 
regularly changing, click on the OK button to start collecting measurements.

Collecting Data

Start communications as described in the preceding section.

To make a measurement with the Cscope position the Cscope at the measurement position and hold the 
Cscope Measure button.  Keep the Measure button depressed until the indicated depth measurement 
has been stable and without “LO” readings for at least 7 seconds.

Once the displayed depth measurement has been stable for at least 7 seconds, release the Measure but-
ton on the Cscope.  GIS360 will then wait for a 4 seconds to be sure that measurements have stopped, 
and will then place a marker on the map.

The marker will contain the data recorded when the Measure button was released, at the location where 
that measurement was made.

Collected depth measurements can be examined by using Edit>Item, then clicking on the marker for the 
measurement.  Collected data will then be displayed as follows:

When all measurements have been taken, go to Tools>Devices, click on the Start/Stop button, and in 
the resulting form click on the Sensor stop button.
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Fine Tuning

This should not be necessary, but it is possible to change the timing parameters for the Cscope interface.

Default operation is as follows:
The user should have collected at least 5 good depth measurements in the last 7 seconds.  Any “LO” or 
zero depth measurements during this period will reset the count of good measurements to zero, so in 
practice unstable measurements should be eliminated.

Once the “Measure” button has been released GIS360 waits for a further 4 seconds to be sure that meas-
urements have really stopped.  This is necessary to eliminate possible problems from communications 
difficulties such as Bluetooth lag.  After this period the data is stored in the survey.

The 7 second measurement timing and the 4 second data-end wait timing can be changed in this form, 
available via Tools>General, hit the Extra button.
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Data Designer 
Intro to DataDesigner
What does DataDesigner do and why do we need it?
Most GIS applications need date entry forms to collect data from the use about items being collected. 
GIS360 uses the DataDesigner to make custom forms for these applications.  
For example a property surveyor might want a data form like this:

			 
This screen allow data entry. The Form contains data fields like Rooms, Type, Owner etc. These fields also 
have different types, Rooms is the number of rooms and is a number, Owner is a Text String, and Type is a 
Picklist of choices.  There are many different types and these will be discussed later in this document.  

Each of these forms relates to a database. For most GIS applications these databases also have a type. 
The Database Type only has three options: either it’s a database for a point database, a line database, or a 
polygon database. For Example a tree might be a point, a fence is a line, and a parcel of land is a polygon.  

Note:The DataDesigner is designed to operate on your PC, it does not operate on a PDA or mobile 
device. However the forms and databases designed with XMLFD are meant to be used on the Mobile 
devices with the GIS360 Mobile software.  

About XML and XSD files 

XML files are text files that contain data.  XSD files are a subset of XML files.  XML files can contain both 
the definition of the Databases as well as the data itself, whereas an XSD file contains only the Database 
Definitions.  The GIS360 Software and 3DSurveyor use XSD files to store the Database definition.  

How to Start and Install DataDesigner 

DataDesigner will install automatically with the installation of the GIS360 Software.  After GIS360 installa-
tion look at your desktop for this icon: 		  and double click on it to Start Data Designer.

Or an alternative  method to Start DataDesigner:
1.	 Select the Start Icon on the lower left of your screen 
2.	 Select All Programs
3.	 Select GIS360 then DataDesigner
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The Carlson GIS360 Data Designer  allows the user to modify GIS360 to exactly fit your needs.  Most func-
tions can be done without programming.

GIS360 has a variety of tools for customizing not only the look and feel of the program 
The main tool is DataDesigner.exe.  This program allows you to change the data structure and databases 
for GIS items.  
Data Collection projects tend to have two major aspects, the design of the data structure, and the design 
of the collection methodology.  
The methodology is mostly the ergonomic design of data entry forms in such a way as to speed up the 
data collection process.   Data Designer can do some of this but for really custom workflows user de-
signed forms are necessary.  

Data Designer 
The Data designer is a tool for editing the 
data schema.  This is where we can modify 
the number and type of attributes.  With 
DataDesigner we can … 
•	 Add Delete and Edit Databases 
•	 Select how each Database will dis-
play Colour, Fill Style, and Icon etc.
•	 Add Delete and Edit fields.
•	 Select Fields types String, Decimal, 
Integer, Photo, Sketch etc.  
•	 Make Picklists 
•	 Define Photograph fields
•	 Define Hidden fields
•	 Make some fields compulsory
Using the data Designer does not require 
programing skills; it is entirely self-co 

tained and easy to use.  

Schemas, XSD files and Data 
The data structure in GIS360 is stored as a schema.  This is where the definition for each datatype is held.  
So for example if you position a Tree then GIS360 will look in the Schema to see which Attributes to put 
on a Tree.  ( How High, what species, etc.)   Then GIS360 will present the user with a Form to fill in those 
attributes.  Each attribute is a field and each field has a type (Number, Text, Date, Picklist)
GIS360 always has a Schema file loaded to define the current data.  These files have an .XSD ending and 
are usually found in the /Schema folder in your main GIS360 folder.    DataDesigner will edit your Schema 
file to change your data.  
Beware NEVER change you Schema in the middle of a survey.  Neither the software or your Computer 
manager will be happy.  This is why you need to think carefully about the data you want to collect before 
you start collecting. 

The basic structure of a Schema is pretty simple 
•	 Schemas are made up of one or more Databases 
•	 Databases are made up of one or more Fields
•	 Each field can have a type and other features to make collection easier
These databases are geographic databases.  Aside from holding a bunch of fields they also define wheth-
er the geographic object is a Point, Line, or Polygon.  

Main Menu – Contains all Menu functions. This is mostly 
used for loading and saving files.    
Databases Window – Is where Databases are added and 
removed from the XML file.  
Fields Window -  Is where Fields are added and removed 
from Databases
Field Options Window – Is where Picklist options are 
added and removed from a Picklist type field.  
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Creating, Editing, and Deleting Fields

Once a Database is selected you will see a list of the field associated with that database appearing in the 
listbox on the right hand side of the screen.  You cannot edit fields without having a Database selected 
first.   

Add Field . Adds a new Field to the Database.  Once selected the user is prompted for the Field 
Name and Type.  The name must be unique to that database.  There are name different field 
types.  

Boolean – 		  Yes No selector 
DateTime – 		  The current data and Time 
Decimal – 		  Decimal (double) numbers 
Listbox – 		  A Picklist of items
Textbox – 		  Enter a String 
Int32 – 			  Enter an Integer
NumericUpDown – 	 Allows you to move an integer up or down by one. 
Photo – 		  Save a picture
Sketch – 		  Make a Sketch 

Edit Field. Will allow you to edit the currently selected field.  

Delete Field. Will Delete the currently selected field.

The Database section is on the left hand side of the DataDesigner window.   In the middle of the Data-
bases panel are the Add, Edit, and Delete databases buttons

Add Database Button. When you press the Add Database you will be prompted for a name and 
type.  The name must be unique to the current schema, it is case sensitive but don’t put two da-
tabases with the same name but different cases.   You will also be asked if you want to make the 
Database Cloud compatible (See section on Cloud).  
Edit Database Button. The Edit Database button will allow you to change the Name of the data-
base and the Type. 
 	
Delete Database Button. Will delete the currently selected database.   

The current database is selected by clicking its name in the list of databases.   

Setting the Appearance of Database Items 

Once you have the Database and that database has been selected.  You can change how that database 
will draw items on the screen.  

Line Color. This will allow you to change the line colour on Polyline databases and the outline 
colour on Polygon databases.  

Fill Colour . This will set the Colour for the filling of Polygons 

Transparency  Sets the Transparency for Polygons.  This will allow you to see what’s under a 
polygon.  

Icon. Every type of database (Point Line or Polygon) must have an Icon.

Creating, Editing, and Deleting Databases 
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Picklists or Listbox fields 

One very common feature on forms are listboxes.  Which are popup lists of possible choices to pick 
from.  If you set your field type to Listbox and make sure that it is the currently selected field then 
the Listbox selector will automatically pop on the screen.  This only appear on Listboxes.

The List in the middle of the selector shows the current list of 
item to select from.  
Typing anything in the Pick box and then pressing the Plus but-
ton will add an item to the list.
Pressing the red X will remove the currently selected item from 
the list
Frequently a list can be quite long and to make entry easier you 
can also press the Add File button and load the list from a Text 
file.  
If the textfile itself is quite long then you could exceed the limits 
of the XSD file you can have the list stored as an external text file 
but linked to the XSD.  This is done by pressing the Add Link File 
Button.  

In the DataDesigner there are special field settings.  These allow for features such as automatic area or 
length calculation for example.   If you select a database and a field, then you may press the Tag button 
which allows you to configure settings for that field.  
 
These special settings can be controlled by reserved words or directly in the Data designer.  Any Field 
name with the correct reserved word will do whatever calculation is necessary.

The Tag button will Tag a field with the neces-
sary options and pressing it will bring up the 
Field Attributes Dialog.  These include the fol-
lowing options.  

Hidden  - This hides a field from the user.  The 
Field still exists and will be imported and ex-
ported.  Normally when data is sent to be used 
in the field there are a lot of fields that the user 
doesn’t actually need to see when he is col-
lecting data.  
View Only – You can see the field but you 
can’t edit it.  
Compulsory – You cannot leave the data entry 
form until this field is entered. 
Increment -  this will increment the field from 
the last time this on this type of item field was 
incremented.  It will start incrementing from 0 
or you can change it on the first entry.  
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Special Field Settings 

	 Global Increment – 	 This is the same as incrementing but works across different types of objects.  
	 Default to Last -  	 This will default the field to the last value that was entered for this field.  
	 Default To – 		  Will default the field to whatever is set in the box below
	 Use for Title – 	 Displays this field value next to the Icon on the map.  
	 Use Unicode – 	 Displays a Unicode Keyboard for data entry in this field.  

	 On the right hand side are the Autofilled field types 
	 Area – Fills in the area of the Polygon 
	 Length – Calculated the length of the Polyline or the perimeter of the polygon 
	 Northing – Fills in the Y coord in local coordinates
	 Easting – Fills in the X coordinate of the coordinates. 
	 Other items on this form are not implemented.  

	 There are also Reserved Words.  Any field with a name that is a reserved word will have that field 
	 filled 	 out upon entry of the form.  The field name must be all uppercase characters. 

	 HECTARES – 	 Calculates the number of Hectares in a polygon
	 ACRES – 	 Calculates the number of Acres in a polygon 
	 LENGTH – 	 Calculates the perimeter length of a polygon or the length of a polyline. 
	 AREA – 	 Calculates the area of a polygon
	 SENSOR -  	 Places a sensor reading in the field  
	
	 PDOP – 	 The last PDOP received by the GPS
	 HDOP – 	 The Last HDOP received by the GPS
	 RMS – 		 The last RMS received by the GPS 
	 DATE – 	 The current date
	 LATITUDE – 	 the Last latitude calculated by the GPS. 
	 LONGITUDE – The last Longitude calculated by the GPS. 
	 NORTHINGS – The last local coordinate Y axis
	 EASTINGS – 	 The last local coordinate X axis 
	 LEVEL – 	 the Last calculated Level

Any reserved word appearing as a field name will cause that value to be automatically calculated and 
placed in the field value.  
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CartoTiff conversion App
Purpose of this conversion is to  convert a TIFF formatted file 
with WGS84 UTM data to CartoGoo’s TILES system file. Carto-
tiff.exe File itself is an integral part of GIS360 for the Windows 
PC installation and you can find it under GIS360 directory.

Tiff files – some notes :The Tiff format is a widespread format where quite often image makers don’t 
have a standard way of georeferencing their map. There is a part within the TIFF file which deals with 
tags and keys. Normally speaking a TIFF file has tags which do not hold much geo-reference data if any. 
However several developers expanded this format  (www.remotesensing.org) to include private tags too 
which does have some geo-reference data (Spot, Intergraph and SoftDesk are examples).
(see http://www.remotesensing.org/geotiff/spec/geotiff6.html#6) 
The year GeoTiff got established more rigorously was when there was a new set of entities introduced 
called:- Keys. These have all the intricate datum and projection data you could wish for. However, in our 
conversion  world we expect the coordinate system to always be UTM based on the WGS84 datum. The 
units have to be in Metres. Also because of the UTM coordinate system, it is only required to have two 
other bits of data:- ZONE number (1 – 60) and hemisphere (North or South). The SEGMENT is calculated 
using the centre of the map transformed into Lat, Lon, Alt. UTM is the standard model used in Google 
Earth. 

CartoTIFF layout

Load your Tiff file here. If you 
have a TFW file that relates to 
it, make sure its leaf name is 
the same as the Tiff file and 
they are in the same directory. 
The moment it is loaded the 
conversion process will begin.

Progress Bar showing progress 
through the current level.

These controls must be set be-
fore loading in the GeoTIFF file.
Extra reduced levels :- shrinks 
the size of the image so that 
it will show when you reduce 
magnification in CartoGoo.
WGS84 UTM Zone:- If there is 
no reference to this in the TIFF 
file, this selection is used in-
stead.
Hemisphere:- If no reference in 
the TIFF file this value is used 
instead.

Zoom level currently (not shown 
until the calculation has ended)
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From Google Satellite Data 

Please note the survey data is 
the same in each case.  You can 
select the tile system using the 
left hand icon in CartoGoo and 
toggle the map type between 
No Map and two other types 
which is what we have done in 
this comparison.

From GIS360 TILES file

Our CartoTiff is getting a bit old and needs a  soon a replacement.  The problems include; the image 
files sizes are getting progressively larger and in a wider variety of formats, and people want to stitch 
multiple images together.   So rather than devote extensive effort on repairing CartoTiff we decided to 
look for a better solution. 

Look on the next page please!
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Geoserver as alternative to CartoTiff

What we found was Geoserver (www.geoserver.org) which is an open source free program that allows 
you to setup your own geospatial server.  Basically what it does is it allows you to load large quantities of 
Vector and Raster data.  It supports a wide variety of formats and doesn’t appear to have size limits.   
 
Once loaded with data then GIS360 can directly grab what it needs.  We have had to add one new option 
to GIS360. 
 
First some notes on how to use GeoServer
 

1.   After Installing Geoserver you need to start the Geoserver Web Interface.  This will appear in your  
Programs selector under Geoserver

 

										          Go under Server and click on 	
										          Start
After launching Geoserver this window will appear

  Server will respond and start to load 
and when finished you will see the message

							       Geoserver Web Interface

2.   Create a new Workspace.   This is where you can put all of your data.
 
	 2.1. Adding a workspace
	 The first step in data loading is usually to create a workspace. This creates a virtual container for 	
	 your project. Multiple layers from multiple sources can all be contained inside a workspace, with 	
	 the primary constraint being that each layer name be unique.

	 1)Navigate to the main GeoServer web interface page.

	 2)Click on the Workspaces link on the left column, under Data.
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3.   Follow the instructions on this page for loading a geotiff.  http://workshops.opengeo.org/geoserv-
er-intro/data/geotiff.html   The only differences are that you should use your workspace name and that 
when it comes to Suggested Tile size choose 256,256

	 3.1. Publishing a GeoTIFF
	 GeoServer can also publish raster imagery. This could be simple georeferenced images (such as 	
	 Blue  Marble imagery), multi-band DEM (digital elevation model) data, or many other options. 		
	 In this section, we will load a simple GeoTIFF containing a shaded relief of land area. The 		
	 layer contains 	standard tri-band RGB values (0-255).

Click to go to the Workspaces page

3) Click on the “Add new workspace” link at the top center of the page.

Workspaces page

4) A workspace is comprised of a Name (also sometimes known as a “namespace prefix”), repre-
sented by a few characters, and a Namespace URI. These two fields must uniquely identify the 
workspace. Fill in the following information:

Creating a new workspace

5) When done, click Submit.

New earth workspace created

With our new workspace cre-
ated and ready to be used, we 
can now start loading our data.
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	 3.1.1. Adding a store
	 The procedure for adding a store for a GeoTIFF is very similar to that of a shapefile. A GeoTIFF, like 	
	 a shapefile, is a store that contains a single layer.

	 a) From the GeoServer web interface page, click on the Stores link on the left side, under Data.

Click this link to go 
to the Stores page

	 b) Click on Add new store.

Stores page

c) Select GeoTIFF under Raster Data Sources.

Adding a GeoTIFF store

d) Fill out the following form:

e) In the box marked URL, type in the full path to the shapefile if known, or click the Browse... 
button to navigate to the file. The file path may be something like:
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Using the file browser to select 
a file

f ) When finished, click Save.

Configuring a GeoTIFF store

3.1.2. Publishing a layer

As with the shapefile, now that store is loaded, we now need to configure and publish the layer 
itself.

a) On the next screen, a list of layers in the store is displayed. Since we are working with a Geo-
TIFF, there is only a single layer. Click the Publish link to configure the layer.

Selecting a layer 
to publish

b) This is the layer configuration page. There are many settings on this page, most of which we 
don’t need to work with just now. We will return to some of these settings later. Fill out the form 
with the following info:

	 1.In the Coordinate Reference System section, set the Declared SRS to EPSG:4326 and 		
	 set the SRS handling to Force declared. This will ensure that the layer is known to 		
	 be in latitude/longitude coordinates.

	 2.In the Bounding Boxes section, click the Compute from data and Compute from native 	
	 bounds links to set the bounding box of the layer.
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Configuring a layer to 
publish (Part 1) Configuring a layer to publish 

(Part 2)

	 3) When finished, click Save.

	 4)Your GeoTIFF is now published in GeoServer. You can now view the layer using the Layer 	
	 Preview as in previous sections. Clicking on the map will display the RGB values for that 	
	 particular point.
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4.   If you have done this then you should Edit your new layer that includes your new geotiff and make 
sure that it is enabled.  
 

5.   You should also make sure that WMS is enabled.  WMS is the tiled Raster map server that is most 
commonly used.
 

6.   Then you need to put the Geoserver WMS link into GIS360.  This is new.  There is now a file called 
WMSservers.txt.  This is where a user can add a service.  The first line of the file contains the name of 
the service (“Doug Raster” etc) and the second contains the request link.  In the case of Doug’s data the 
request link was as follows….
 
“http://localhost:8080/geoserver/earth/wms?FORMAT=image/jpeg&VERSION=1.1.1&SERVICE=WMS&RE
QUEST=GetMap&Layers=HVGBtest&styles=&bbox={0},{1},{2},{3}&width={4}&height={5}&SRS=EPSG:4326”
 
Notice how we are using a localhost and not an IP connection.  The only two things in that line you 
should need to change is “earth” which is your workgroup, and “HVGBtest” which is your layer name.  
If you want to have the data accessable from GIS360 in the field via wireless then you need to have a 
proper IP address instead of local host. 
 

7.   Then Start GIS360 on your PC and you will find your new WMS server listed under maptypes.  Select 
it and view as any other Raster map service.  The data will be tiled and available at a variety of different 
zoom levels. 
 

8.   Once selected then you can save Tiles files in GIS360,  or you can use the data live via the internet 
connection. 
 
This system has many plus points.  Multiple images can be grouped together.  Vector data can also be 
added and superimposed. 
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Forge Interface (Forge is unit mainly made for forestry applications
Important: This system relies on the replacement of the standard F4 Distance and F4 Height applications 
with modified versions.

It is necessary to manually start F4 Distance and F4 Height BEFORE starting GIS360.
F4 Distance should be used to turn on the transponder, and perform any necessary calibration prior to 
using it with GIS360.

The F4 Distance application can be set to provide either an absolute distance, or a slope-adjusted (hori-
zontal) distance.  Please note that GIS360 ignores this setting and always uses the absolute distance 
(what we would think of as the “slope” distance).

The interface to GIS360 is provided in a modified keypad in GIS360.  If GIS360 detects that it is running 
on a Forge device where the F4 Distance and F4 Height applications are present, and there is NO laser 
rangefinder configured, then the alternative keypad will be presented in place of the standard one.

This keypad form looks like 
this…

There are 4 special “Forge” buttons in the keypad form which 
replace the standard laser rangefinder buttons.  The function 
of these buttons is as follows…

Confirming the prompt will take a measurement.  This will be the absolute distance to the sensor.  The 
result is entered into the keypad form.  

Please note, the F4 Distance application can compute a “Horizontal” distance, but this is ignored by 
GIS360.

Distance (absolute)
Pressing this button will lead to a prompt…
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Height (ultrasonic)
The sensor should first be positioned on the tree trunk, or just to the side of it, or just in 
front of it.   Pressing this button will lead to a “Measure” prompt.  Confirming the prompt 
will take the distance measurement.  

After that the F4 Height application will be presented but with a different interface….

 A prompt will appear to advise you that you are first 
required to target the transponder in the viewer.  Centre 
the transponder in the crosshairs and wait for the angle 
(displayed above the Fire button) to stabilise.  When it is 
stable click on “Fire” (or press F3). 

You will now be prompted to target the bottom of 
the tree.  As for the first stage, wait for the angle 
value to stabilise then click on Fire again.

Finally you will be prompted to repeat this for the top 
of the tree.  When all three angles have been collected 
the calculated tree height will be entered in the 
GIS360 keypad form.

Height (taped)
If for some reason the transponder cannot be placed on the tree, has been left at home, or perhaps its 
battery is flat, then you can still measure the tree height using a taped measurement.  First measure 
the distance between the tree and your position using a tape measure.

Click on the “Height-Taped” button and enter the measured distance in the keypad which is presented.  
Once you confirm entry of the taped distance then the sequence of operations will be similar to the 
Height-ultrasonic method, except the first measurement will be to roughly half-way up the tree rather 
than to the transponder.
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Help
Just displays a form which identifies buttons (hardware and software) related to these processes…

Notes.

If preferred you can take distance measurements with less screen interaction as follows.  When keypad 
form is showing:
1. Press F4 to display F4 Distance application.
2. Press F1 to take measurement.
3. When measurement is taken, GIS360 will automatically re-appear.

If the F4 Distance application is running then you can switch to it from GIS360 by pressing the F4 hard-
ware button.  You can return to GIS360 from F4 Distance by pressing F4 again.

If the F4 Height application is running then you can switch to it from GIS360 by pressing the F5 hardware 
button. .  You can return to GIS360 from F4 Height by pressing F5 again.
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GIS 360 API 

The Carlson GIS360 API  allows the user to modify GIS360 to exactly fit their needs.  Most functions can 
be done without programming but for truly custom functions the user can use C# or Visual Basic to add 
additional functionality.   

Introduction 

GIS360 has a variety of tools for customizing not only the look and feel of the program 
The main tool is DataDesigner.exe.  This program allows you to change the data structure and databases 
for GIS items.  
Data Collection projects tend to have two major aspects, the design of the data structure, and the design 
of the collection methodology.  
The methodology is mostly the ergonomic design of data entry forms in such a way as to speed up the 
data collection process.   Data Designer can do some of this but for really custom workflows user de-
signed forms are necessary.  

Data Designer 
The Data designer is a tool for editing the data schema.  This is 
where we can modify the number and type of attributes.  With 
DataDesigner we can … 
•	 Add Delete and Edit Databases 
•	 Select how each Database will display Colour, Fill Style, and 

Icon etc.
•	 Add Delete and Edit fields.
•	 Select Fields types String, Decimal, Integer, Photo, Sketch etc.  
•	 Make Picklists 
•	 Define Photograph fields
•	 Define Hidden fields
•	 Make some fields compulsory
Using the data Designer does not require programing skills; it is 
entirely self-contained and easy to use.

Schemas, XSD files and Data 
The data structure in GIS360 is stored as a schema.  This is where the definition for each datatype is held.  
So for example if you position a Tree then GIS360 will look in the Schema to see which Attributes to put 
on a Tree.  ( How High, what species, etc.)   Then GIS360 will present the user with a Form to fill in those 
attributes.  Each attribute is a field and each field has a type (Number, Text, Date, Picklist)
GIS360 always has a Schema file loaded to define the current data.  These files have an .XSD ending and 
are usually found in the /Schema folder in your main GIS360 folder.    DataDesigner will edit your Schema 
file to change your data.  
Beware NEVER change you Schema in the middle of a survey.  Neither the software or your Computer 
manager will be happy.  This is why you need to think carefully about the data you want to collect before 
you start collecting. 

The basic structure of a Schema is pretty simple 
•	 Schemas are made up of one or more Databases 
•	 Databases are made up of one or more Fields
•	 Each field can have a type and other features to make collection easier
These databases are geographic databases.  Aside from holding a bunch of fields they also define wheth-
er the geographic object is a Point, Line, or Polygon.  

IMPORTANT NOTE: THIS PART IS ONLY 
FOR SYSTEM ADMINISTRATOR
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Creating, Editing, and Deleting Databases 

The Database section is on the left hand side of the DataDesigner window.   In the middle of the Data-
bases panel are the Add, Edit, and Delete databases buttons

Add Database Button. When you press the Add Database you will be prompted for a name 
and type.  The name must be unique to the current schema, it is case sensitive but don’t put 
two databases with the same name but different cases.   You will also be asked if you want to 
make the Database Cloud compatible (See section on Cloud).  

Edit Database Button. The Edit Database button will allow you to change the Name of the 
database and the Type. 

Delete Database Button. Will delete the currently selected database.   

The current database is selected by clicking its name in the list of databases.   

Setting the Appearance of Database Items 

Once you have the Database and that database has been selected.  You can change how that database 
will draw items on the screen.  

Line Color. This will allow you to change the line colour on Polyline databases and the outline 
colour on Polygon databases.  

Fill Colour . This will set the Colour for the filling of Polygons 

Transparency  Sets the Transparency for Polygons.  This will allow you to see what’s under a 
polygon.  

Icon. Every type of database (Point Line or Polygon) must have an Icon. 
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Creating, Editing, and Deleting Fields

Once a Database is selected you will see a list of the field associated with that database appearing in the 
listbox on the right hand side of the screen.  You cannot edit fields without having a Database selected 
first.   

Add Field . Adds a new Field to the Database.  Once selected the user is prompted for the 
Field Name and Type.  The name must be unique to that database.  

There are name different field types.  
Boolean – 		  Yes No selector 
DateTime – 		  The current data and Time 
Decimal – 		  Decimal (double) numbers 
Listbox – 		  A Picklist of items
Textbox – 		  Enter a String 
Int32 – 		  Enter an Integer
NumericUpDown – 	 Allows you to move an integer up or down by one. 
Photo – 		  Save a picture
Sketch – 		  Make a Sketch 

Edit Field. Will allow you to edit the currently selected field.  

Delete Field. Will Delete the currently selected field.  

Picklists or Listbox fields 

One very common feature on forms are listboxes.  Which are popup lists of possible choices to pick 
from.  If you set your field type to Listbox and make sure that it is the currently selected field then 
the Listbox selector will automatically pop on the screen.  This only appear on Listboxes.

The List in the middle of the selector shows the cur-
rent list of item to select from.  
Typing anything in the Pick box and then pressing 
the Plus button will add an item to the list.
Pressing the red X will remove the currently selected 
item from the list
Frequently list can be quite long and to make entry 
easier you can also press the Add File button and 
load the list from a Text file.  
If the textfile itself is quite long then you could 
exceed the limits of the XSD file you can have the list 
stored as an external text file but linked to the XSD.  
This is done by pressing the Add Link File Button.  
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Special Field Settings 

In the DataDesigner there are special field settings.  These allow for features such as automatic area or 
length calculation for example.   If you select a database and a field, then you may press the Tag button 
which allows you to configure settings for that field.  
 
These special settings can be controlled by reserved words or directly in the Data designer.  Any Field 
name with the correct reserved word will do whatever calculation is necessary.

 

	 Global Increment – 	 This is the same as incrementing but works across different types of objects.  
	 Default to Last -  	 This will default the field to the last value that was entered for this field.  
	 Default To – 		  Will default the field to whatever is set in the box below
	 Use for Title – 	 Displays this field value next to the Icon on the map.  
	 Use Unicode – 	 Displays a Unicode Keyboard for data entry in this field.  

	 On the right hand side are the Autofilled field types 
	 Area – Fills in the area of the Polygon 
	 Length – Calculated the length of the Polyline or the perimeter of the polygon 
	 Northing – Fills in the Y coord in local coordinates
	 Easting – Fills in the X coordinate of the coordinates. 
	 Other items on this form are not implemented.  

	 There are also Reserved Words.  Any field with a name that is a reserved word will have that field 
§filled 	out upon entry of the form.  The field name must be all uppercase characters. 

	 HECTARES – 	 Calculates the number of Hectares in a polygon
	 ACRES – 	 Calculates the number of Acres in a polygon 
	 LENGTH – 	 Calculates the perimeter length of a polygon or the length of a polyline. 
	 AREA – 	 Calculates the area of a polygon
	 SENSOR -  	 Places a sensor reading in the field  
	

The Tag button will Tag a field with the 
necessary options and pressing it will 
bring up the Field Attributes Dialog.  
These include the following options.  

Hidden  - This hides a field from the 
user.  The Field still exists and will be 
imported and exported.  Normally when 
data is sent to be used in the field there 
are a lot of fields that the user doesn’t 
actually need to see when he is collect-
ing data.  
View Only – You can see the field but 
you can’t edit it.  
Compulsory – You cannot leave the 
data entry form until this field is entered. 
Increment -  this will increment the field 
from the last time this on this type of 
item field was incremented.  It will start 
incrementing from 0 or you can change 
it on the first entry.  
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PDOP – 	 The last PDOP received by the GPS
HDOP – 	 The Last HDOP received by the GPS
RMS – 		 The last RMS received by the GPS 
DATE – 	 The current date
LATITUDE – 	 the Last latitude calculated by the GPS. 
LONGITUDE – The last Longitude calculated by the GPS. 
NORTHINGS – The last local coordinate Y axis
EASTINGS – 	 The last local coordinate X axis 
LEVEL – 	 the Last calculated Leven

Any reserved word appearing as a field name will cause that value to be automatically calculated and 
placed in the field value.  

Special Databases 
Special Databases are reserved names for databases that have special functions.  If these databases ap-
pear in your schema list then then GIS360 will automatically enable those special functions. 
  
SETUP 
A Setup database is almost like a log in form.  It will come on the screen whenever you start a new site.  
This is used by users who need to have a user sign in before they start working.  For example the might 
want to get the start time of any survey or the surveyor should have to enter his name. there can only be 
one Setup object in a dataset at any time.  

WORKTICKET 
The WorkTicket datatype is a database that holds tasks to do.  (A TODO list)  Each task is displayed in 
the task list.  The Ticket can contain any fields that the user needs but as an example it will usually have 
fields like Task, Date, Assigned to,  Completed   etc.  Each Ticket must have a coordinate so that if the user 
selects one GIS360 will navigate to that position.  

MDISTANCE 
This is a measured distance.   If this database exists in the Schema then GIS360 will keep any distance 
measured and place it in a record of this database.   This is mostly used when you want to record meas-
urements on a map.

Calculation Module
The Calculations module is perhaps slightly misnamed.  It originally came about because users wanted 
to perform custom calculations on data items as they were collecting the data.  For example one user 
wanted to generate a serial number based the geographic position of the attribute.  This was entirely 
specific to this particular user.  
The Calculation Module allowed him to write a small program in c# or Visual Basic.  This program is called 
every time a new item is generated and the program runs and calculates the serial number automati-
cally.  
The Calculations module is called both on entry of a new item and on completion.  So it can be used to 
perform calculations before the GIS360 data form is presented to the user and also after the user has 
entered data.  
To use the Calculations module the user must make a small exe program.  The key is that the exe file 
must be placed in the schemas folder, and it must follow the correct naming convention. 
The name of calculation exe’s is as follows: 
{Name of Schema}{Name of Database}Calculations.exe 
So for example :  CadasterBuildingCalculations.exe 
Is a valid calculations exe, “Cadaster” is the name of the schema  and “Building” is the name of the data-
base.  Everytime GIS360 is about to put the GIS form on the screen whether it be from creating a new 
Building or from editing an existing one, GIS 360 will check to see if the exe exists.  
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If it does exist then GIS360 will write all of the existing form data out to an ASCII file and then run the exe.  
This exe can now read the text file and do any calculations that you want.  It can also do any other tasks 
that you want.  You can read external databases; you can put forms on the screen.  Almost anything you 
can write a program for can be done here.  
When the exe has finished it must write the text file with the data fields back out in the same format and 
then exit.  
GIS360 then reads this text file and puts the data in the right place in GIS360.  

Format of Text file

A text file of data is written for the Calculation module each time a GIS form is opened.  
The same file is then read by GIS360 when the calculations program has finished.  
The format is of the following:

6			   (Number  of Fields)
Field 1		  (First Field)
Field2		  (Second Field)
Field3		  (Third Field)
Hidden Field1	 (First Hidden Field)
Hidden Field2	 (Second Hidden Field)
Hidden Field3 	 (Third Hidden Field) 
Easting		  ( Center coordinate Easting) 
Northing 		  (Centre Coordinate Northing)
Level 			  ( Centre Coordinate Level) 

Fields are made in the Data Designer.  Hidden fields are fields that don’t display on the GIS form.  
For example you might want to have a time stamp that the user can see or edit, this could be a 
hidden field.  If all the fields on the form are hidden then the GISform will not display, but the 
Calculations program will still be called and it can fill in the fields.  

Example Program
The following is a small example program to make a Calculations exe.  All this does is to take the 
Area field (no 4) and Truncate it to an integer. 
string[] Fields = new string[100];
string Xstr = “”;   // Easting
string Ystr = “”;   // Northing
string Zstr = “”;   // Level

// The Reference folder is where we look for the calculations 
string strAppDir = Path.GetDirectoryName(Assembly.GetExecutingAssembly().GetModules()[0].
FullyQualifiedName);
            string Refdir = strAppDir;    //  We know its in the Schema dir along with the EXE  +”\\Refer-
ence”;
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           string filename = Refdir + “\\Calculations.dat”;

            // If the file is there then read in all of the fields.  
            try
            {
            if (File.Exists(filename))
	 {
// First Read in the data fields
              string st = “”;
              int NoFields = 0;
              using (StreamReader sr = new StreamReader(filename))
                {
                st = sr.ReadLine();
                st = st.Trim();
                NoFields = Convert.ToInt32(st);
                for (int i = 1; i <= NoFields; i++)
                     Fields[i] = sr.ReadLine();

                Xstr = sr.ReadLine();
                Ystr = sr.ReadLine();
                Zstr = sr.ReadLine();

                sr.Close();
                }
// Now do something with the data
// In this case we are just truncating the Area field.  Area is Field[4]
            if (Fields[4] != “”)  // Truncate the Area 
               {
               try
                 {
                 double doubleArea = Convert.ToDouble(Fields[4]);
                 Int32 Iarea = Convert.ToInt32(doubleArea);
                 Fields[4] = Convert.ToString(Iarea);
                 }
               catch { } 
               }
//  Now we write the fields out in the same format
// GIS360 will read the file and put the fields in the GIS database. 
            StreamWriter sw = File.CreateText(filename);
            sw.WriteLine(NoFields);
            for (int i = 1; i <= NoFields; i++)
                sw.WriteLine((string)Fields[i]);
            sw.WriteLine(Xstr);
            sw.WriteLine(Ystr);
            sw.WriteLine(Zstr);
            sw.Close();
            }
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Creating an external Form 

GIS360 provides a standard interface for the entry and editing of GIS data.  The standard 
interface is suitable for most data entry requirements, however it is unsuitable for appli-
cations that require maintenance of databases external to GIS360.  All data collected and 
edited using the standard form is stored within GIS360’s internal data structure.
There may also be instances where a custom data entry form is desirable, for example to 
replace a paper form whilst retaining a similar layout with which the end user is familiar.
GIS360 allows the use of external third-party EXE files to be added to replace the standard 
GIS entry form to address these requirements.  External EXE files can be written using any 
language which supports Windows Messaging.  Example solutions are provided to dem-
onstrate the concepts involved, these solutions are written in C# using Visual Studio 2008.

Setting the Data Designer to use the external form.  

The first step before making an external form is to set the Schema to use that form.  Start 
Data Designer and load your schema.  Then select the database that you want to use the 
external for with.  
Then check the Auto External EXE as shown below:

If you wish to have your user designed form come on the screen without having the 
standard form.

Design your Form 

User data forms are a separate exe that GIS360 calls when needed.  In effect they are two 
separate programs.  The User Form exe can be written in any programming language but 
we recommend Microsoft C# or Visual Basic.  
If you are going to be using the form on the Windows Mobile platform then you must 
build your form to run on that platform.  This means that you will have to use Visual Studio 
2008, if you are running on the PC platform then you can use more recent versions.  
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Once you start your new project in Visual Studio and then you can literally use any of the tools and user 
interface components in the toolbox.  

External Connections and connecting to other applications  

As you have seen users can create their own forms and these forms will be presented directly to the user 
instead of the standard GIS360 forms, thus taking advantage of all the graphical tools and ergonomic 
layout possibilities of Visual Studio.  But the advantages can be more than just cosmetic this external form 
can be a complete software application, can have its own database links and external communication.  
This is particularly useful if the application requires linking to an external relational database or spread-
sheet.  It’s similar to the Calculations system but does not have a time limit and the external program can 
stay open and doesn’t need to be exited.  This is useful if the external form needs to load a large external 
database or any other time consuming task.  
There may also be instances where a custom data entry form is desirable, for example to replace a paper 
form whilst retaining a similar layout with which the end user is familiar.
GIS360 allows the use of external third-party EXE files to be added to replace the standard GIS entry form 
to address these requirements.  External EXE files can be written using any language which supports Win-
dows Messaging.  Example solutions are provided to demonstrate the concepts involved.  These solutions 
are written in C# using Visual Studio 2008.

The Basics 

There are two modes in which an external Form can be displayed.
Augmentation Mode.  In this mode creating or editing a placemark in GIS360 will cause the standard 
GIS Entry Form to be displayed.  Within the form there will be one editable field which, if selected for 
edit, will cause the external EXE to be activated for custom data entry and manipulation.  Exiting the 
external form will lead to re-entry into the standard form.  Typically this mode would be used when the 
external  EXE is required to operate with an external database.  Other uses would be where the end user 
wanted to provide a custom entry form for a single specialised field.
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Replacement Mode.  In this mode creating or editing a placemark in GIS360 will immediately activate 
the external EXE for data entry, and on exiting the external form the control will immediately return to 
GIS360 without displaying the standard form.  Typically this mode would be used where the end user 
required the custom entry form to cater for all fields to be entered.
The mode used is determined by the way the Schema is configured.  The examples provided demon-
strate both of these modes of operation.  For each platform there are two example EXEs provided, the 
content of the EXEs is identical, only their names are different.
There are two parts to making an external form for GIS360.  The first part is the creation of the Schema 
which will instruct GIS360 to look for an external EXE, the second part is the design and creation of the 
external EXE itself.  In the majority of cases, all that will be required is the addition of the schema and the 
external EXE to the GIS360 “Schemas” folder.

Separate examples are provided for the Windows operating system and the Windows Mobile/CE operat-
ing system.  The code for these two platforms is very similar, the main difference between the two plat-
forms is in the code which controls and monitors communication between GIS360 and the external EXEs.
The examples demonstrate both Augmentation and Replacement modes of operation so three files are 
used:
PC version:  

	 ExtDemo.xsd
	 PC_ExtDemoPointDataIndex.exe§
	 PC_ExtDemoPointPartDataIndex.exe

Mobile version: 
	 ExtDemo.xsd
	 ExtDemoPointDataIndex.exe
	 ExtDemoPointPartDataIndex.exe

Configuring the Schema 

GIS360 schemas are created and modified using the DataDesigner utility which is provided with the Win-
dows version of GIS360.   It is easiest to load in the sample ExtDemo.xsd Schema to see how the different 
modes of operation are configured.
The “ExtDemo” schema contains 3 definitions for types of Point data as follows…

	 Point.  This database uses an external EXE Form in “Replacement” mode.
	 PointPart.  This database uses the standard GIS form, but if the “DataIndex” field is clicked in the 
standard form then the external EXE Form will be activated (Augment.
	 PointStandard.  This database uses the standard GIS form only, it never activates an external EXE.
	 NOTE:  In Augmentation mode, if the external EXE is absent then GIS360 will revert to using the 
standard form.
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Point – Replacement Mode

PointPart – Augmentation Mode

In this database, the “Auto External EXE” checkbox is 
checked which indicates to GIS360 that the external EXE is 
required to be run in “Replacement” mode.
In addition, the various fields within the database should 
have their “Hidden” checkboxes checked.

In this database, the “Auto External EXE” checkbox is unchecked 
which indicates to GIS360 that the external EXE is required to be 
run only when required, in “Augmentation” mode.

In addition, the field to which the external EXE is related must be 
visible in the standard GIS form, so must have its “Hidden” check-
box unchecked.
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Setting your Fields to Hidden

If you want your form on the 
screen and the GIS360 form to be 
hidden completely then you need 
to set all of the fields to hidden.  
If all fields are hidden then the 
GIS360 form will not display at all.  
To set your fields to hidden.  
Select the database in the data-
bases column. 
Then Select your field in the fields 
column
Then press the field attributes 
button and made sure that Hid-
den is checked.   

Then save your schema so that 
the changes are saved the the 
Schema file.

Naming the external EXE 

The name of the external EXE form must adhere to a fixed format which combines the Schema, Database, 
and Field names.
For Windows Mobile/CE platforms…
	 Schema Name + Database Name + Field Name
 …so for the example provided for the Point database relating to the DataIndex field this gives “ExtDe-
moPointDataIndex.exe”. 
For Windows platforms a “PC_” prefix is added…  
	 “PC_” + Schema Name + Database Name + Field Name
 …so for the example provided for the Point database relating to the DataIndex field this gives “PC_Ext-
DemoPointDataIndex.exe”. 

External EXE behaviour

The external EXE is started by GIS360 the first time it is required.  After its first use the EXE should stay 
resident in memory but hidden from the user.  When GIS360 needs the EXE to present itself again it will 
send a message to the EXE requesting it to display.
When a user clicks on OK or Cancel in the external EXE, the EXE should respond by hiding itself, it should 
not terminate.  If OK is clicked then the EXE will also need to save any data which is to be passed back to 
GIS360 in two text files.
GIS360 interacts with external EXEs by first preparing all necessary information for them in two text files, 
then sending a message to the appropriate EXE to instruct it to display.
There are 2 messages sent from GIS360 to which the EXE must respond…
MasterToSlaveCodes.Display – When this is received the EXE should make itself visible, and bring itself to 
the foreground.
MasterToSlaveCodes.Terminate – When this is received the EXE should safely save its data and close.
To see example code for these functions, look at the “WndProc” methods.
NOTE:  There are two other #”MasterToSlaveCodes” messages defined in the code, “PassMeasure”, and 
“SaveDataNow”.  In practice these messages are never used so there is no requirement to add methods to 
respond to these messages.
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Data exchange

When GIS360 requires and external EXE to display it will first prepare two text files which pass data to the 
EXE.
DataIn.dat – This is a UTF-8 encoded XML file which contains the values for all fields in the current record 
for the current database.
ExtInfo.txt – This file is used to pass information about access dates/times, and the current GPS position 
and quality
In the examples, these files are loaded and interpreted by the “LoadDataFromGIS360” method. .  The ex-
ample code places the “ExtInfo” data in an “ExtInfo” object.
Once the user has updated the fields and clicked OK in the external EXE Form, the EXE should create a file 
called “DataOut.dat” in the same folder as itself.  “DataOut.dat” should be a UTF-8 encoded XML file con-
taining the data for the fields edited in the EXE.  For the examples, this file would contain data similar to 
this…
<?xml version=”1.0” standalone=”yes”?>
<DocumentElement>
  <Properties>
    <Name>PointID</Name>
    <Value>123</Value>
    <Type>textbox</Type>
    <Data />
  </Properties>
  <Properties>
    <Name>DataIndex</Name>
    <Value>7639</Value>
    <Type>textbox</Type>
    <Data />
  </Properties>
</DocumentElement>

Once the output data is saved, the EXE should send a “SlaveToMasterCodes.OK” message to GIS360 and 
then hide itself.
If the user Cancels the form, then the EXE does not need to prepare a “DataOut.dat” file, it just needs to 
send a “SlaveToMasterCodes.Cancel” message to GIS360 and then hide itself.
Examples of these operations can be found in the “pictureBoxOK_Click” and “pictureBoxCancel_Click” 
methods in the examples.

Managing external Databases 

In some applications the data to be maintained will be in an external database rather than from GIS360’s 
internal data structure.  The external database could be large and performance would suffer if this had 
to be loaded every time the external EXE form was displayed.  This is reason why the external EXE should 
operate by simply hiding itself and staying resident in memory when it is not displayed.

Handling external databases will depend on the format of the database so is not covered in the example 
programmes.   There are two skeleton methods in the examples to indicate where the external database 
should be loaded and saved.  These are the “LoadExternalDatabase()” and “SaveExternalDatabase()” meth-
ods.
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Report Generator 

GIS360 can also generate custom reports.  To make a custom reports you must make a custom exe and 
place this in the /Reports subfolder.  When you save a file in XLS format GIS360 will save the data in a CSV 
in the reports folder and then run the selected exe.

In theory there are a wide variety of tools that can be used to make the reports.  We found that 
ClosedXML worked very well and was easy to adapt to our needs.     http://closedxml.codeplex.com/
The Report EXE format a file called Showcase.xml which is then loaded by Excel.  
For example here is a report generated by GIS360 for positioning and recording electricity meters.

The data was collected in GIS360 then the user exports as File type XLS.  Then Excel will appear on the 
machine with the report already loaded.  
 The code snippet to generate the above report is 
        public ReportForm()
        {
            InitializeComponent();
            wb = new XLWorkbook();
            ws = wb.Worksheets.Add(“Contacts”);

            //Title
            ws.Cell(“B2”).Value = “Meter Survey Details”;
            ws.Cell(“E3”).Value = “Meter type (Tick)”;
            ws.Cell(“I3”).Value = “Tariff Class”;
            ws.Cell(“B4”).Value = “Str ID “;
            ws.Cell(“C4”).Value = “Account No/ Cust ID/ User ID “;
            ws.Cell(“D4”).Value = “Meter ID”;
            ws.Cell(“E4”).Value = “Prepaid”;
            ws.Cell(“F4”).Value = “Credit”;
            ws.Cell(“G4”).Value = “Single Phase”;
            ws.Cell(“H4”).Value = “Three Phase”;
            ws.Cell(“I4”).Value = “Residential (Tick)”;
            ws.Cell(“J4”).Value = “Commercial (Tick)”;
            ws.Cell(“K4”).Value = “Other”;
            ws.Cell(“L4”).Value = “Activity Code Name”;
            ws.Cell(“M4”).Value = “Telephone”;
            ws.Cell(“N4”).Value = “Email”;

            //From worksheet
            string rangestring1 = “B2:N” +(RowNo + 4).ToString();
            var rngTable = ws.Range(rangestring1);

            rngTable.FirstCell().Style
                .Font.SetBold()
                .Fill.SetBackgroundColor(XLColor.CornflowerBlue)
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  .Alignment.SetHorizontal(XLAlignmentHorizontalValues.Center);
            rngTable.Range(“A1:M1”).Merge(); //or rngTable.Row(1).Merge()

            rngTable.Range(“A2:C2”).Merge();
            rngTable.Range(“A2:C2”).Style.Fill.BackgroundColor = XLColor.Aqua;

            rngTable.Range(“D2:G2”).Merge();
            rngTable.Range(“D2:G2”).Style.Fill.BackgroundColor = XLColor.Aqua;
            rngTable.Range(“D2:G2”).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            rngTable.Range(“D2:G2”).Style.Border.LeftBorder = XLBorderStyleValues.Thin;
            rngTable.Range(“D2:G2”).Style.Border.RightBorder = XLBorderStyleValues.Thin;
            rngTable.Range(“D2:G2”).Style.Border.TopBorder = XLBorderStyleValues.Thin; 

            rngTable.Range(“H2:J2”).Merge();
            rngTable.Range(“H2:J2”).Style.Fill.BackgroundColor = XLColor.Aqua;
            rngTable.Range(“H2:J2”).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            rngTable.Range(“H2:J2”).Style.Border.LeftBorder = XLBorderStyleValues.Thin;
            rngTable.Range(“H2:J2”).Style.Border.RightBorder = XLBorderStyleValues.Thin;
            rngTable.Range(“H2:J2”).Style.Border.TopBorder = XLBorderStyleValues.Thin;

            rngTable.Range(“K2:M2”).Merge();
            rngTable.Range(“K2:M2”).Style.Fill.BackgroundColor = XLColor.Aqua;
           var rngHeaders = rngTable.Range(“A3:L3”); // The address is relative to rngTable (NOT the worksheet)
            rngHeaders.Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            rngHeaders.Style.Font.Bold = true;
            rngHeaders.Style.Font.FontColor = XLColor.DarkBlue;
            rngHeaders.Style.Fill.BackgroundColor = XLColor.Aqua;

            LoadData(AppDir() + “\\METER.csv”);

            string rangestring = “B4:N”+(RowNo).ToString();
            var rngData = ws.Range(rangestring);
            var excelTable = rngData.CreateTable();

            // Add the totals row
            excelTable.ShowTotalsRow = true;
            
            //Add thick borders to the contents of our spreadsheet
            ws.RangeUsed().Style.Border.OutsideBorder = XLBorderStyleValues.Thick;
            ws.Columns().AdjustToContents(); 
            wb.SaveAs(AppDir() + “//Showcase.xlsx”);
Excel.Application excelApp = new Excel.Application();

  // if you want to make excel visible to user, set this property to true, false by default
  excelApp.Visible = true;

 // open an existing workbook
  string workbookPath = AppDir() + “//Showcase.xlsx”;
    Excel.Workbook excelWorkbook = excelApp.Workbooks.Open(workbookPath,
        0, false, 5, “”, “”, false, Excel.XlPlatform.xlWindows, “”,
        true, false, 0, true, false, false);
        }
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        private void AddRow(string[] row)
        {
            string CellName = “B” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[0];
            
            CellName = “C”+Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[1];

            CellName = “D” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[2];

            if (row[3] == “Prepaid”)
            {
                CellName = “E” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }
            else
            {
                CellName = “F” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }

            if (row[4].Contains(“ingle”))
            {
                CellName = “G” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }
            else
            {
                CellName = “H” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }

            if (row[5].Contains(“Residential”))
            {
                CellName = “I” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }
            else
            {
               CellName = “J” + Convert.ToString(RowNo);
                ws.Cell(CellName).Value = “X”;
                ws.Cell(CellName).Style.Alignment.Horizontal = XLAlignmentHorizontalValues.Center;
            }
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            CellName = “K” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[6];

            CellName = “L” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[7];

            CellName = “M” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[8];

            CellName = “N” + Convert.ToString(RowNo);
            ws.Cell(CellName).Value = row[9];
        }

        private void LoadData(string filename)
        {
                using (StreamReader readFile = new StreamReader(filename))
                {
                    string firstline = readFile.ReadLine();
                    string line = “”;
                    //string[] row;

                    while ((line = readFile.ReadLine()) != null)
                    {
                        string[ ] row = line.Split(‘,’);
                        RowNo++;
                        AddRow(row);           
                    }
                }
        }

User designed Field Entry

User Designed field entry is when one field in a form needs to have special attention.  This can be be-
cause it needs to link to an external database, or any other special means of picking.  For example in for-
estry there is frequently a list of species.  This list can be so long that it is too long for a combobox.  With 
this function the user can write a custom control that allows the user to answer questions to get down  to 
the exact species.  So it might start with  “ Is it coniferous or deciduous? “ 

User Defined Drawing  

User defined drawing is when the user inserts a custom appearance for the GIS items being drawn.   For 
example some users like to have the Tree canopy drawn based on distances from the trunk in the NSEW 
directions.  

All of the above functions give GIS360 to perform virtually any GIS task and give the user exactly the tool 
they need. 
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Writing – Reading your own Project files  

Project files are useful because they give you a way to compress everything needed to work into a single 
file.  This file can then be easily emailed, copied, or transferred to the cloud.  
A GIS360 PRJ file (project file) is just a ZIP file of data and settings.  If you take a PRJ file and change the 
suffix to ZIP it will load into WinZip or any other Zip program.  
The PRJ ( ZIP ) file can contain the following items.  
1.	 A KMZ datafile.  
This is where the main GIS data is held

2.	 TempGlobals.txt  This file contains all of the global settings that go along with the project.   It 
must be placed into the Reference subfolder.  See section below for description of the file   

3.	 User Images for the Work Button   “hi_lmnew.png” , “hi_lmold.png”,  “lo_lmnew.png”,  “lo_lmold.
png”  These must go into the Images subfolder.

4.	 The current Schema file.  This must go into the schema folder. 

5.	 Any XML or TXT file that is in the schema subfolder gets included into the Project and will need to 
be returned there if the project is unzipped.

6.	 Any *.Tiles files that are currently used are included into the project file.  They must be unzipped 
into the MyDocuments subfolder.  

7.	 Any Icons used are included and must be returned to the Icons subfolder

8.	 Any ENM, ENI ENS files and they need to go into their choses folder.   The folder name is in the 
TempGlobals.txt file.  

Definition of TempGlobals.txt 

TempGlobals,txt is a test file that contains global variable settings for the project file.  Each project file 
must contain this file.  It tells GIS360 how to configure itself and setup the screen so that it is exactly like 
the moment the tempglobals file was saved.  

Presetused - 			   This is the current map projection 
homeearthcoord.lat
homeearthcoord.lon – 	 This is the current Home Position
ecentre.lat
ecentre.lon - 			  This is the Centre of the current screen view 
zoomlevel -  			   The current Zoom level   (0  - 18) 
MapType1 – 			   The current maptype (Selection 1)  This can be a map server or Tiles files
MapType2 - 			   The current maptype (Selection 2)  This can be a map server or Tiles files
LLMDirectory – 		  The ENM file folder 
Units       			   (“metres”, “imperial_feet”,”us_feet”)
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PC Platform, XP,Vista,Windows 7 & Windows 8 Windows Mobile 6.1 & 6.5  and CE 6.0 Platform
Features Freeware Standard Profes-

sional Post.Proc Office Freeware Standard Profes-
sional

Post.Pro-
cessing

Limited to 15 points Yes No No No No Yes No No No
NMEA GPS No Yes Yes Yes No No Yes Yes Yes
GPS Simulation Yes Yes Yes Yes Yes Yes Yes Yes Yes
RTK/DGPS  GPS interfaces to many different 
Brands and models Simul. No Yes Yes No Simul. No Yes Yes

GPS/GNSS “You are Here” Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Google Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Google Satellite Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display ESRI Maps 5 servers On-/offline like: Yes Yes Yes Yes Yes Yes Yes Yes Yes
ArcGIS_World_Physical_Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
ArcGIS_World_Shaded_Relief On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
ArcGIS_World_Street_Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
ArcGIS_World_Terrain_Base On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
ArcGIS_World_Topo_Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Bing Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Yahoo Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Bing Satellite Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Yahoo Satellite Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display Open Street Map On-/offline Yes Yes Yes Yes Yes Yes Yes Yes Yes
Display WMS On-/offline
Collect Digital Photos within GIS schema Yes Yes Yes Yes Yes Yes Yes Yes Yes
Load and Save ESRI Shape Files Yes Yes Yes Yes Yes Yes Yes Yes Yes
Save and Load Project Yes Yes Yes Yes Yes Yes Yes Yes Yes
Load Local Map Tiles Yes Yes Yes Yes Yes Yes Yes Yes Yes
GIS Data Designer, create schema for GIS data 
collection Yes Yes Yes Yes Yes No No No No

GIS schema comes with predefine  entries Yes Yes Yes Yes Yes Yes Yes Yes Yes
Save Local Map Tiles Yes Yes Yes Yes Yes Yes Yes Yes Yes
Stake Out and Navigation Yes Yes Yes Yes Yes Yes Yes Yes Yes
COGO tools Yes Yes Yes Yes Yes Yes Yes Yes Yes
Bilateration (US Term?) Yes Yes Yes Yes Yes Yes Yes Yes Yes
Chain and offset (US term?) Yes Yes Yes Yes Yes Yes Yes Yes Yes
Walk method Yes Yes Yes Yes Yes Yes Yes Yes Yes
Distance and bearing Yes Yes Yes Yes Yes Yes Yes Yes Yes
Intersections/Line work Yes Yes Yes Yes Yes Yes Yes Yes Yes
Line extention Yes Yes Yes Yes Yes Yes Yes Yes Yes
Parallel Yes Yes Yes Yes Yes Yes Yes Yes Yes
Point snap Yes Yes Yes Yes Yes Yes Yes Yes Yes
Digitalization Yes Yes Yes Yes Yes Yes Yes Yes Yes
Add, View and Edit Attributes Yes Yes Yes Yes Yes Yes Yes Yes Yes
View DXF DWG Files Yes Yes Yes Yes Yes Yes Yes Yes Yes
Import/Export DXF/DWG Yes Yes Yes Yes Yes No No No No
Import/Export CSV Yes Yes Yes Yes Yes Yes Yes Yes Yes
Snap, Tap, Enter Points Yes Yes Yes Yes Yes Yes Yes Yes Yes
GPS Tools Yes Yes Yes Yes Yes Yes Yes Yes Yes
Auto Area and Length Calc Yes Yes Yes Yes Yes Yes Yes Yes Yes
WGS 84 and Local Grids Yes Yes Yes Yes Yes Yes Yes Yes Yes
Grids in Local formats Yes Yes Yes Yes Yes Yes Yes Yes Yes
Laser Toolbox Yes Yes Yes Yes No Yes Yes Yes Yes
KML, KMZ Google Compatible Yes Yes Yes Yes Yes Yes Yes Yes Yes
Work in wireless ‘blocked’ areas Yes Yes Yes Yes No Yes Yes Yes Yes
Total Station Interface to many different 
Brands and models Yes Yes Yes Yes No Yes Yes Yes Yes

GPS Post-Processing Yes No No Yes No Yes No No Yes
Direct Field to Office connection Yes Yes Yes Yes Yes Yes Yes Yes Yes
Cloud download and upload Yes Yes Yes Yes Yes Yes Yes Yes Yes
Cloud Teamwork Yes Yes Yes Yes Yes Yes Yes Yes Yes
Converting GEOTiff Yes Yes Yes Yes Yes No No No No
API available for third party integration No Yes Yes Yes Yes No Yes Yes Yes
Edit geometry for lines and areas Yes Yes Yes Yes Yes Yes Yes Yes Yes
Localization of GNSS signal to a local grid Yes Yes Yes Yes Yes Yes Yes Yes Yes
Set home position with desired address Yes Yes Yes Yes Yes No No No No
Interface to different sensors, like Cable 
detection, Echo sounder, etc. Yes Yes Yes Yes No Yes Yes Yes Yes

Print map Yes Yes Yes Yes Yes No No No No
Multilingual Yes Yes Yes Yes Yes Yes Yes Yes Yes
Nesting Yes Yes Yes Yes Yes Yes Yes Yes Yes
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